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Chapter 1: Getting Started

This chapter deals with common tasks that are necessary to understand before
beginning to use  Microsoft Dynamics CRM
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Common Tasks

Getting Started and Finding Help

Introduction to Microsoft Dynamics CRM

Welcome to Microsoft Dynamics CRM

Microsoft Dynamics CRM is designed to help your organization acquire and retain customers and reduce the time spent
on administrative tasks. At its core, Microsoft Dynamics CRM provides a robust account management system that
automatically tracks activities and revenue. Microsoft Dynamics CRM enables you to perform and automate many
common business tasks, including:

Easily access informaton about business records from one place.
Schedule activities, track them, and send e-mail.

Generate reports.

Manage marketing lists.

Track advertising and marketing campaigns.

Sort customer responses to your sales and marketing initiatives.
Keep detailed notes and an activity history for each business record.

Microsoft Dynamics CRM also can run from within Microsoft Office Outlook.

Sales Force Automation

Sales departments can use Sales Force Automation to track salesrelated activities and revenue. This system includes
analytical, operational, and collaborative tools that you can use to improve and maintain good customer relations. Using
Sales Force Automation, you can:

Qualify leads.

Manage contacts and accounts.

Track quotes, orders, and invoices.

Manage and track e-mail, phone call, and other communication activities with customers.
Run direct e-mail campaigns and measure their success.

Create and access a database of products that your organization sells.

Marketing Automation

Marketing departments can use Marketing Automation to manage many marketing-related activities. Using Marketing
Automation, you can:

Create targeted marketing lists.
Plan and run campaigns.

Track each campaign response and lead generated from campaigns.
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Customer Service Management

The Customer Service area is designed specifically to meet the needs of customer support and product support
departments that handle telephone, e -mail, and Web-based service requests from customers. Using the Customer
Servicearea, you can:

e Track individual cases and manage services.
e Track and share common problems and solutions in a knowledge base.

e Manage customer contracts.

Appointment  -based Service Scheduling
Customer service representatives can manage service activitiesfor your business. Using Service Scheduling, you can:

e Define the services you offer.
e |dentify available resources and equipment for service activities.

e Define work schedules for individual resources, as well as their locations.

Reporting and Analysis

Microsoft Dynamics CRM includes several features to help you generate reports and analyze data:

e Run a default report.
e Create an Advanced Find query to find a filtered set of records and then export the list for analysis.

e Create a custom report using Microsoft SQL Server Reporting Services or other reporting tools.

Customization

System administrators can adapt Microsoft Dynamics CRM to fit the needs of their business organizations. Using the
customization capabilities of Microsoft Dynamics CRM, you can:

e Create new Microsoft Dynamics CRMentities, attributes, and application forms without custom
programming.
e Customize forms and views for enhanced integration with other Web applications, portals, and

business systems.

e Apply form validation and add client-side business logic through scripting.

Workflow

Beyond the business automation included in Microsoft Dynamics CRM, you can use additional workflows to further
automate your organization's business logic. Then you can make your workflows available as an on-demand workflow
or automatic workflow.

Microsoft Dynamics CRM for Microsoft Office Outlook

Microsoft Dynamics CRM for Outlook is a client application that provides the Sales Force Automation functionality of
Microsoft Dynamics CRM within Outlook. Whenyou run Microsoft Dynamics CRM for Outlook you can work either in
online or offline mode.

Find Answers
You can find information by using Help, the Resource Center, and Documentation Feedback.
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Help

Help provides conceptual overviews for each area and step-by-step procedures for tasks. Help topics may reference
things that are unavailable or may differ from the Microsoft Dynamics CRM user interface for the following reasons:

e Functionality depends on a user's security role. Some Microsoft Dynamics CRM fits, forms, and
options are not available to all users. Help topics for restricted areas are marked with g? .
e [f your organization has created a new record type or customized existing record types, Help will not

match the changes. For instructions about customizing help, see Customizing Help (Mcrosoft
Dynamics CRM SDK)

Help is updated periodically. You are currently reading Microsoft Dynamics CRM Help4.1. To check to see if a more
recent update is available, on the Microsoft Dynamics CRMHelp menu, click Help Updates . You also can sign-up to
receive notification of updates to Microsoft Dynamics CRM, including Help updates. More information: Manage
Administration Settings

Resource Center

The Resource Center provides articles explaining how to do common tasks, and includes links to the Microsdt Dynamics
CRM community newsgroups, blogs, and trainings. The Resource Center is updated regularly.

Documentation Feedback

The documentation team wants to make it easy for you to find answers. In every Help topic, you can rate whether it
was helpful and tell us what you were looking for.

All feedback must be in English. Your feedback will be used to make improvements to the Help and shape the content
delivered to the Resource Center.

Accessibility for People with Disabilities
Microsoft is committed to making its products and services easier for everyone to use. Microsoft Dynamics CRM offers
assistance through keyboard shortcuts to address issues faced by people with limited dexterity or motion disabilities.

If you are using High Contrast settings in ei ther your browser or operating systems, you should also set the High
Contrast option in your personal options.

More information: Set Personal Options

Note

For more information about features, products, and services that make Microsoft products more accessible for all users,
on the Start menu, click Help and Support , and then click Accessibility .

Welcome to the Resource Center

The Resource Center brings together information that will help you get the most from your use of Microsoft Dynamics
CRM. The Resouce Center provides a central location where you can find:

e Information to help you get started.

e Tips to make you more productive.

In-depth descriptions of product features and recommendations for using them to build your business.
e Examples and advice from subject matter experts.

e Easy access to other online resources related to Microsoft Dynamics CRM.

Search tools that help you find information related to Microsoft Dynamics CRM within the Resource
Center and on other resources avaiable on the web.
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Information in the Resource Center is regularly updated and organized to help you quickly find the information you
need.

The Highlights page shows you new content or content that has been highly rated.

The Sales page groups information that will be of interest to salespeople, sales managers, and
executives focused on using Microsoft Dynamics CRM to increase sales.

The Marketing page focuses on information that shows how to identify and qualify leads using
Microsoft Dynamics CRM.

The Service page provides insight about how you can use Microsoft Dynamics CRM to provide
superior customer service and manage the services you provide.

The Settings page is where you will find more technical information about configuring and
customizing Microsoft Dynamics CRM to support all aspects or your business.

Use Keyboard Shortcuts

The shortcut keys described in this section refer to the U.S. keyboard layout. Keys on other layouts might not
correspond exactly to the keys on a U.S. keyboard.

¥ Genenal keyboard shortcuts

To Press
Copy text. CTRL+C
Paste text. CTRL+V
Undo previous text change. CTRL+Z
Save a record. CTRL+S
Close a record. CTRL+F4
Cut text. CTRL+X
Delete text. DELETE

Delete selected text immediately without putting it SHIFT+DELETE
on the Clipboard.
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Move the insertion point to the start of the next
word.

Move the insertion point to the start of the previous
word.

Select all text in the current field.

Display the System menu for the active window.

Move forward through the form's fields.

Move backward through the form's fields.

Display the shortcut menu for the selected item.

Display the corresponding menu.

Cancel the current task or command, or close a
selected list or dialog box.

Move up through a list of records.

Move down through a list of records.

Expand or collapse the preview in a list view.

Open the selected record.

Select all records on the current page.

F Dialog box keyboard shortcuts

Microsoft Dynamics CRM 4.0

CTRL+RIGHT ARROW

CTRL+LEFT ARROW

CTRL+A

ALT+SPACEBAR

TAB

SHIFT+TAB

SHIFT+F10

ALT+the key for the underlined letter in the menu
name.

ESC

UP ARROW

DOWN ARROW

SPACEBAR

ENTER

CTRL+A
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To

Move to the next option or option group.

Move to the previous option or option group.

Complete the command for the active option or
button.

Move between options in an open list, or between
options in a group of options.

Cancel a command, or close a selected list or dialog
box.

¥ Form keyboard shortcuts

To

Save.

Save and close.

Expand or collapse Form Assistant.

Cancel edits and close (Close).

Delete the record.

Save and then open a new form (Save and New).

F Accessibility keyboard shortcuts

Press

TAB

SHIFT+TAB

ENTER

ARROW keys

ESC

Press

CTRL+S or SHIFT+F12

ALT+S

CTRL+SHIFT+F

ESC

CTRL+D

CTRL+SHIFT+S

In a computer running on Microsoft Windows, you can set system accessibility options to change the way

Microsoft Dynamics CRM 4.0
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you work. For example, you can use Windows Sticky Keys if you have difficulty holding down two or more
keys at a time, such as CTRL+P. Sticky Keys enable you to press the CTRL key and have it remain active
until you press the P.

To Press

Switch Sticky Keys on and off. SHIFT five times

Switch Filter Keys on and off. RIGHT SHIFT for eight seconds

Switch Toggle Keyson and off. NUM LOCK for five seconds

Switch High Contrast on and off. LEFT ALT+LEFT SHIFT+PRINT SCREEN
Switch Mouse Keys on and off. LEFT ALT+LEFT SHIFT+NUM LOCK

Managing Records

Find Things
There are several ways to locate a specific record when you're working with a list of records, or when you're filling out a
form. With Advanced Find, you can also save your search as a saved view to use again later.

Find records in a list

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

e Use one of the following methods to find records in a list:

b Filter a list

Select a view from the View drop-down list at the top of any list of records. Some lists, such as Activities
and History , provide additional choices to help filter a list.

The View list includes two types of views: System Views and My Views.

k- Search for a text string

In the Search for records box, type a few letters to narrow your search, and then click the Lookup
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button @I

Use an asterisk (* ) as a wildcard if the text you're looking for is not at the beginning of a field. For
example, to find all records that contain the word "advanced" in the searched columns, enter *advanced

Important  The search is not related to the view currently selected in the View menu. Only active records
are returned.

F Tip

For each record type, which fields are searched can be customized. By default, the following
fields are searched:

Account: Account Name, Account Number, Email

Activity and individual activity types including Appointment, E -malil, Letter, Fax, and
Phone Call: Subject

Campaign: Campaign Code, Name

Case: Title, Case Number

Contact: Full Name, First Name, Middle Name, Last Name, Email, Case Number
Contract: Contract Name

Lead: Company Name, First Name, Last Name, Name, Topic

Marketing List: Name

Opportunity: Topic

Quote, Order, Invoice: Name

Product: Product Name, ID

Sales Literature: Title

More information: Work with Entities.

F Sort a list

To sort a list of records, click a column heading. To reverse the sort order, click the column
heading again.

An arrow icon in the column heading shows that the list is sorted: the Ascending Sort icon
indicates ascending, and the Descending Sort icon =indicates descending.

To sort by an additional column, press SHIFT while you click the additional column heading.

You cannot sort by columns that display data from a related record type.

F Use Advanced Find to filter the list

1.

To start an Advanced Find search:

In the View box, select the view that is closest to what you want, and then on the Standard
toolbar, click Advanced Find .

-OR-
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2.

On the Actions toolbar, click Advanced Find .

Specify criteria for your search and the columns to display.
More information: Work with Advanced Find

k- Create your own view

1.

To start an Advanced Find search:
In the View box, select the view that is closest to what you want, and then on the Standard
toolbar, click Advanced Find .
- OR-
On the Actions toolbar, click Advanced Find .
Specify criteria for your search and the columns to display.
More information: Work with Advanced Find
Click Save As.
In the Query Properties dialog box, in the Name field, type a name for the search.
In the Description box, type a brief description, a nd then click OK.
The search is saved as a view and appears on theSaved Views tab of the Advanced Find form.
This new view is also available from the list page for the record type in the View box, in the My
Views section.
F Go to the next page of records

If there is more than one page of records available to view in the list of records, use the Page arrows at
the bottom of the list to view the additional pages.

F Use the alphabetical index

For lists that include an Index at the bottom of the | ist:

F Tips

10

To view records with the information in the sorted column that begin with a specific letter, click
the letter.

To view records with the information in the sorted column that begin with 0 -9, click # .

To view all records, click All .

To make sure a list of records is current, at the top of the list, click the Refresh button - , or right -

click any record and then click Refresh list .

To preview a record, click the Preview button ¥ next to the record. To close the preview, click the

Close Preview button =.

To see the exact criteria used for any saved view and most system views, select the view, on the

Standard toolbar click Advanced Find , and then click Show Details .

It is not possible to find or retrieve deleted records.
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e |n any list, s elect multiple records:
O Select several records by pressing the CTRL key while you click each record.

0 Select a sequence of records by clicking the first record that you want, and then press the
SHIFT key while you select the last record that you want.

0 Select all records on the page by selecting the Select/clear all records on this page
check box at the top of the list.

e By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can
increase the number of records displayed and thereby increase the number of records you can
select at one time. To display up to a maximum of 250 records per page:

1. Onthe Tools menu, click Options .

2. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.

3. ClickOK.

This changes the number of items that is displayed for all lists, which may slow response time when you

switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

Find records w hile filling out a form

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

e When you fill out a form and need to select a record in a field, you can use the Lookup button @I
or in some forms, you also can use the Form Assistant pane.

k Use the Lookup button

1. Click the Lookup button @I

2. Inthe Look for box, if needed, select a record type, enter some letters to search for, and then

click the Find button EI

3. Select the record, click the Add Selected Records  button , and then click OK.
4. Inthe Advanced Find page, click Find .

i ORT
Use the Form Assistant pane:

e To show or hide the Form Assistant pane, in the title bar of the pane, click the Expand

button & or Collapse button '\?«".

e To collapse or expand an individual section, in the title bar of the section, click the Collapse
button < or the Expand button .
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e To select arecord:

1. Putthe insertion point in the text box for which you want to search for a record.
If a suggestion is available, the Form Assistant pane filters and displays the appropriate
records.

2. Inthe Form Assistant pane, click a record.
The appropriate data fills the text box.

e  To create follow-up activities related to the open record:

1. From an open record, on the Actions toolbar, click Follow Up =
The Form Assistant pane displays a partially completed activity.

2. Select the activity type.
You cannot create a follow up task activity for an e -mail activity created with a quick
campaign. Select a phone call, letter, fax, e-mail or appointment activity.

3. Complete the required fields.

4. Click Save or Save and Open .
Create, edit, or save an Advanced Find search

F Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. On the Standard toolbar, click Advanced Find .

Tip: Advanced Find starts with criteria based on where you are in Microsoft Dynamics CRM. If you
click Advanced Find from a view, the criteria for that view will be preloaded for you.

T ORI

To edit a saved search, on the Standard toolbar, click Advanced Find , click the Saved Views tab,
and then double-click the saved view.

2. Specify the search criteria.

e |f Show Details is visible in the criteria toolbar, click it.

a. F Specify what to search for

b. Inthe Look for list, select the type of record you want to search for, such as
Accounts , Leads, or Users.

c. ClickSelect to select criteria for the search, including the field to search on (for
example, Account Name or City ), the query relational operator, and the values to
locate (for example, "Seattle" or "E -mail").

You can select fields from the current record type, or from related records.

e  For some values, you can click the Lookup button @I to open the Select Values dialog
box and select the value you want.

At the bottom of the Select list, the Related section shows related record types are. When you select a
related record type, a new Select link appears to select fields from this related record type.
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I Clear, delete, or group search criteria clauses

e  Clear all search criteria to start over.
a. ClickClear to remove all criteria.
b. Inthe confirmation message, click OK.

e Delete a row of search criteria.

Click the Options menu  button - next to a search criteria row, and then click Delete.

a. Inthe confirmation message, click OK.

e  Group criteria.

Click the Options menu  button - next to a search criteria row, and then click Select
Row .

To group search criteria, you must select two or mor e rows for the same record type.
For example, Sales Stage and Est. Revenue are both field values in the Opportunity
record type and two rows that specify search criteria for these fields can be grouped.
However, rows with field values from Account and Opportunity record types cannot
be grouped.

a. On the Filter toolbar, select Group AND or Group OR .
b. Repeat steps a and b to create additional criteria groups.
e Select and deselect grouped criteria.

Click the Options menu  button = next to a search criteria row that has been
selected, and then click Deselect Row . You can unselect rows from a group or
individually.

a. Click the Options menu button - next to the group, and then click Select Group
to select a group, or click Deselect Group to unselect a group that has been previously
selected.

e Add a search criteria clause to a criteria group.
Click the Options menu  button - next to the group, and then click Add Clause.

a. Add search criteria to the new clause.
e Ungroup rows of criteria that you have grouped togethe r using Group AND or Group OR .

Click the Options menu  button - next to the group you want to ungroup, and
then click Ungroup .

a. Repeat this step to ungroup additional search criteria groups.

e Change aGroup AND group to a Group OR group, or a Group OR group to a Group AND
group.

Click the Options menu  button = next to the group, and then click Change to
OR or Change to AND .

a. Repeat this step to change additional search criteria groups.
e  Hide or delete a row in Simple view:

To hide a row, click the Options menu button = next to a search criteria row, and
then click Hide in Simple Mode

a. To make a hidden row visible, click Show in Simple Mode
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Specify the columns to include in the search results.
Click Edit Columns , and then click Add Columns .
Select the record type that includes the columns you want to add.

Select the check box next to the columns you want to add. If a column isn't listed, contact
your system administrator.

Click OK.
The following options are also available:

e  To adjust the width of a column, click the column, click Change Properties , select a
width, and then click OK.

e To reorder columns, select a column, and use the arrow keys to move it to the left or
right.

e Toremove a column, select it, and then click Remove .
Click OK.
Specify the sort order.

Click Edit Columns , click Configure Sorting , and specify the column to sort on, and the
sort order.

Tip: Each view is sorted by only one column. However, after you click Find, you can sort by
additional columns. To sort a search results list by an additional column, press SHIFT while
you click the additional column header.

You can only sort on columns from th e primary record type.

f)  Save the search as a saved view.

a.

If you're saving an existing saved view, click Save. If you are saving a new view or want to
change the name of the view because you changed the criteria, click Save As.

In the Query Properties dialog box, in the Name field, type a name for the search.
In the Description box, type a brief description, an d then click OK.

The search is saved as a view and appears on theSaved Views tab of the Advanced Find
form. This new view is also available from the list page for the record type in the View box,
in the My Views section.

Click Find . The selected records are displayed.

Click Back to Query to return to the Find tab.

e When you specify search criteria to find activity records, you can either search through all types of
activities or select one type of activity to search, such as Task or Appointment.

e The columns that are displayed by default are controlled by the Advanced Find View for the record
type. More information: Work with Entities.

e |f you need to search based on the names of people who participated in an activity, in the Advanced
Find criteria, you must search fields in the related activity party. You can search based on the
person's name (Party field), or by their role in the activity, such as sender or recipient
(Participation Type  field).

For example, to find e-mail messages sent to a specific contact:
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a. Inthe Activities list, in the Type box, select E-mail .

b. Click Advanced Find , and then click Show Details .

c. ClickSelect, and then in the Related section, select Activity Parties (Activity)
d. Under Activity Parties (Activity) , click Select .

e. Inthe Fields section, click Participation Type , click Enter Value , and then click the

Select Values button El

f.  Inthe Available Values list, select To Recipient , click the Add Selected Records
button , and then click OK.

g. Under Activity Parties (Activity) , click Select .
h. Inthe Fields section, click Party .

i.  Click the Equals Current User operator, and change it to Equals .

j-  Click Enter Value , and then click the Lookup button @I

k. Inthe Look for box, select Contact , enter some letters to search for, and then click Start
search .

. Select the contact, click the Add Selected Records  button , and then click OK.

m. Inthe Advanced Find page, click Find .

Note

You cannot use Advanced Find to find recordsrelated to quick campaigns.

Working with saved Advanced Find searches

k- Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

e You can run, share, assign, delete, or deactivate a saved view that you own.

If another user has shared a saved view with you, what you can do will depend on the specific
privileges they have given to you: Share, Assign, Delete, or Write.

F Run a saved search

On any list page in the View box, in the My Views section, select a saved view.
If there is not a My Views section, there are no saved searches for this record type.

T ORT

On the Standard toolbar, click Advanced Find , and then click the Saved Views tab. Double-click a saved
search, and then click Find.

k Share a saved search

1. Onthe Standard toolbar, click Advanced Find , and then click the Saved Views tab.
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Select the view. On the Actions toolbar, click More Actions , and then click Sharing .
In the sharing dialog box, under Common Tasks , click Add User/Team .

In the Look Up Records dialog box, in the Look for list, select the type of record you want to
find.

In the Search for records  box, type the first few letters of the name of the record to narrow

your search, and then click the Find button EI

In the list of available records, click a user or team to select it, and then click the Add Selected
Records button to add the user or team to the Selected records list.

Click OK.

In the sharing dialog box, select the type of share access that you want. The available permissions
are: Read, Write, Delete, Append, Assign, or Share.

Click OK.
The saved view will show up in the My Views section of your coworker's View list.

To cancel any changes that you have made and retain the previous permissions settings, click
Reset .

To select or clear all permissions on a selected item, click Toggle All Permissions of the
Selected Items

F Assign a saved search

1.

2.
3.

4.

On the Standard toolbar, click Advanced Find , and then click the Saved Views tab.
Select the view, and then on the Actions toolbar, click the Assign button &’
In the Assign dialog box, click:

e Assignto me
Use this option to assign the record to yourself.

T ORT

e Assign to another user
Click the Lookup button @I type a part of the user's name, click the Find button

EI, double-click the user's name, and then to close Look Up Records dialog box,
click OK.

Click OK.

k' Deactivate a saved search

1.
2.

On the Standard toolbar, click Advanced Find , and then click the Saved Views tab.

Select the view, and then on the More Actions menu, click Deactivate .
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k' Delete a saved search

3. On the Standard toolbar, click Advanced Find , and then click the Saved View s tab.

4. Select the view, and then on the Actions toolbar, click the Delete button x

k- E-mail or copy a link to a saved search

Send a shortcut in an e -mail
1. On the Actions toolbar, click Send Shortcut , and then click Of Current View

2. Complete the e-mail form and send.

Copy a shortcut

3. On the Actions toolbar, click Copy Shortcut , and then click Of Current View

4. Paste the shortcut into any application that supports copy and paste. For example, in Microsoft
Office Word, press CTRL+V.

More information: Send or Copy a Shortcut

Delete Things
Caution Once you delete a record, it cannot be retrieved.

Typically you should only delete records that you entered by mistake. For some record types, you can deactivate or
close the record instead. Not all record types can be deleted. For details, select Special cases .

Delete records

F Can | do this task?

If the Delete button X is not visible on the toolbar, the security role assigned to your account does
not have permission to delete this type of record. To check your permissions for a specific record, open

=

the record, click the File menu button , and then click Properties .

If you are deleting a record that has child records, you can delete it only if you also have permission to
delete any child records.

More information about specific permissions and performing this task while offline: Common Task
Permissions

1. In any list of records, select the record that you want to delete.

T ORIV
In any list, select multiple records:

e  Select several records by pressing the CTRL key while you click each record.

e Select a sequence of records by clicking the first record that you want, and then press the
SHIFT key while you select the last record that you want.
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e Select all records on the page by selecting the Select/clear all records on this page check
box at the top of the list.

F Tip

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 records per page:

4. Onthe Tools menu, click Options .

5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.
6. ClickOK.

This changes the number of items that is displayed for all lists, which may slow response time when you
switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

On the Actions toolbar, click the Delete button X

If you are deleting accounts or contacts, you have the option to deactivate the record
instead of deleting it. In the Delete Confirmation  dialog box, to delete the record, click Delete ,
or to deactivate it, click Deactivate .

For other record types, in the Confirm Deletion dialog box, click OK.

Notes

e \When you delete a record, all its relationships to other records are also deleted.

e |f the record has child records, and you have permission to delete the child records, the child records
will also be deleted.

Special Cases

More
Record Type Notes Information
Accounts Can also be deactivated. Work with Accounts

Work with Queues
Activities in Queues When you delete an e-mail message in

a queue, it is removed from the
queue, but is not deleted as an active
activity. To delete it, you must delete
it from the Activities list.

When you delete other activity types
from a queue, the activity record is
deleted both from the queue and from
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Microsoft Dynamics CRM.

Business Units Can be deactivated, but not deleted. Work with Business Units
Cases Can also be canceled. Work with Cases
Contacts Can also be deactivated. Work with Contacts
Knowledge Base Articles Articles must be unpublished from the  Work with Articles

knowledge base before being deleted.

Invoices Canceled or completed invoices cannot Work with Invoices

be deleted. Completed invoices can be

canceled.
Leads Can also be disqualified. Work with Leads
Marketing Lists Can also be deactivated. Work with Marketing Lists
Orders Only active orders can be deleted. As  Work with Orders

an alternative, orders can be canceled.

Opportunities Can also be closed. Work with Opportunities
Price Lists Can also be deactivated. Work with Price Lists
Products Can only be deleted from the product = Work with Products

catalog in the Settings area.
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Quick Campaigns Deleting a quick campaign record Work with Quick Campaigns
deletes all of the activities created by
the quick campaign, even if those
activities were not yet complete.

Quotes Only draft quotes can be deleted. You Work with Quotes
can select Revise on the Actions menu
to return an active quote to draft

status.
Services Can be deactivated, but not deleted. Work with Services
Teams Can remove members, but cannot Work with Teams

delete or deactivate.

Users Can be deactivated, but not deleted. Manage a User's Record

Remove an attached file

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. Open the record that you want.

2. For most record types, click the Notes tab.
e On the E-mail form, click the Attachments tab.
e On the Service Activity form, click the Service Activity tab.

e  On the Case form, click the Notes and Article tab.
3. Double-click the status row of the note that contains the attachment you wantto remove.

4. To keep the note, but remove the attachment, in the Note form, in the File Attachment area, click
Remove , click OK, and then click OK again.

T ORI

To remove the note and the attachment, on the Actions '~ menu, click Delete Note , and then
click OK.

5. Click Save or Save and Close .
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Note

You cannot update an attached file. Instead, save the file on your computer and edit the file, delete the attachment,
and then attach the edited file.

Print Things

Print the details of a record

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. In the list of records, open the record that you want.

. On the Actions toolbar, click the Print button 'ﬁ.
. Inthe Preview form, click Print .

. Inthe Print dialog box, select the print options you want, and then click Print .

a A W N

. On the Standard toolbar of the Preview form, click Close.

Note

To print a note, open the record, click the Notes tab, right-click the note that you want, and then click Print .

Print a list of records

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. On the Actions toolbar, click the Print button j

2. If the records in the list extend beyond the current view, you will see the Print List dialog box.
To print a list that is limited to the items listed on the current page, click All records on
current page , and then click OK.

T ORI

To print a list of all items that are on all pages for that view, click All records on all pages , and
then click OK.

3. In the Preview form, click Print .
4. In the Print dialog box, select the print options you want, and then click Print .

5. On the Standard toolbar of the Preview form, click Close.

F Tips
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e By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can
increase the number of records displayed and thereby increase the number of records you can select
at one time. To display up to a maximum of 250 records per page:

1. Onthe Tools menu, click Options .

2. Onthe General tab, in the Records Per Page list, select the number of records to
display per page.

3. ClickOK.
This changes the number of items that is displayed for all lists, which may slow response time when

you switch record types. Therefore, you might want to set it back to a smaller number when you are
done with this bulk action.

e If you need to print other columns than the ones in the list, use Advanced Find to create a new view
that includes all the columns you need. More information: Work with Advanced Find

e |f you want to format the list before printing it, export the list to Microsoft Office Excel, and format it
there. More information: Export Data to Excel

e When you print a list, a title describing the list is not included. If you need a title on your printout,
export the list to Microsoft Office Excel, add a title, and then print the worksheet.

Print the details of an activity from a calendar

F Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

You can print the details of an appointment or service activity from the Workplace calendar or the Service calendar.

1. Locate and open the appointment or service activity you want to print.

2. On the Actions toolbar, click the Print button ﬁ
3. In the Preview dialog box, click Print .
4. In the Print dialog box, set the printing options you want, and then click Print .

5. On the Standard toolbar, click Close.

Note

To print the entire calendar as you see it in the window, click Print in Microsoft Internet Exp lorer.

Run a report

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Report Permissions

1. Find and open a report:
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k' From the Reports area

a. Inthe Workplace , under My Work , click Reports .

b. To narrow the list, enter the first few letters of the report name, or use the asterisk (*) wildcard in

the Search for records box and then click the Find button EI You can also select a view.

c. Inthe reports list, double -click the report that you want to run.

If the report has a default filter, the default filter will be displayed. Follow step 2 to change the filter.
Tip: To run a report without seeing the defaul t filter, select the report, and then on the Actions toolbar,
click More Actions , and then click Run Report .

k' From a list of records, including the results of an Advanced Find search

Only reports that relate to the current record type will be available.
You can run some reports on all records in the list, up to ten selected records, or without limiting the
records as if you were running the report from the Reports area.

e Torun areporton all records on the list:

a. On the Actions toolbar, click Reports =7
b. Under Run on Selected Records , click the name of the report.

c. Inthe Select Records dialog box, click All records on all pages in the current view
and then click Run Report .

e Torun areport on up to ten selected records from the list:

a. Select the records to include. Select several records by pressing the CTRL key while you
click each record.

b.  On the Actions toolbar, click Reports .
c. Under Run on Selected Records , click the name of th e report.

d. Inthe Select Records dialog box, click The selected records , and then click Run
Report .

e To run a report without limiting records to items on the list:
a. On the Actions toolbar, click Reports .
b. If the report is listed under Run on All Records , select the report.
i ORI
Under Run on Selected Records , click the name of the report. In the Select Records
dialog box, click All applicable records , and then click Run Report .
T ORI

If the report you want to run is not listed, you must go to the Reports area to run the
report.
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k' From arecord

Only reports that relate to the current record type will be available.

To run a report including data from just one record:

. . . '
a. With arecord open, on the Actions toolbar, click Reports =

b. Under Run on Current Record , click the name of the report.

F From Microsoft Dynamics CRM for Outlook

All reports can be run when you are online.

To run a report while you are offline, you must first create a local data group that includes the report, as
well as a local data group that includes any data that should be included in the report.

To create a local data group that contains reports, on th e CRM menu, click Modify Local Data Groups
click New , select the the Report record type, and then define the criteria for which reports to include.
More information: Work with Data to Take Offline

e To run reports from the Reports area, in the Outlook Navigation Pane, under Microsoft
Dynamics CRM |, click Workplace , click My Work , click Reports , and then select a report to
run.

e To select a report from a record or list, follow the procedures above. These steps work the same
way in Microsoft Dynamics CRM for Outlook

k From a report you saved locally

If you have saved a report on your computer or shared file system that reads dynamic data from Microsoft
Dynamics CRM, to open it, browse to the folder that contains your saved report, and double -click the file.

If the report offers filter criteria, if n eeded, modify the filter criteria and then click Run
Report .

The list of existing report filtering criteria is grouped by record types that you can use in the filter,
such as Accounts or Contacts .

To edit a parameter in simple mode, click the underlined value and enter a new value.
T ORI
To edit the filter criteria in detailed mode:

Click Edit Filter .

a. To add a criteria row:

1. Inthe area for the record type that the field belongs to, click Select , and specify the
field to filter on.

2. Click the query relational operator, and select an operator.
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3. ClickEnter Value , and enter a value to filter on. For some values, you can click the

Select Values button El to open the Select Values dialog box and select the
value you want.

To group criteria, you must select two or more rows for the same record type. For example,
Sales Stage and Est. Revenue are both field values in the Opportunity record type and
two rows that specify filter criteria for these fi elds can be grouped. However, rows with field
values from different record types, such as Account and Opportunity record types, cannot
be grouped.

0. For each row you want to group, in detailed mode, click the Options menu
button = for that row, and then cli ck Select Row .

1. On the Filter toolbar, select Group AND or Group OR .

2.  Toremove a row from a group, click the Options menu button -+ for that row, and
then click Delete .

3. To select a group, click the Options menu button = for that group, and then click
Select Group .

4. To add a criteria clause to a group, click the Options menu button = for that group,
click Add Clause , and then select the field, query relational operator, and value.

5. To unselect a group that has been previously selected, click the Options men u
button - for that group, and then click Deselect Group .

6. To ungroup a group, click the Options menu button - for that group, and then
click Ungroup .

7. Tochange aGroup AND group to a Group OR group, or a Group OR group to a
Group AND group, click the Options menu  button - for that group, and then click
Change to OR or Change to AND .

To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm .
To delete a row, click the Options menu button = for that row, a nd then click Delete .

To hide a row in simple mode, while you are in detailed mode, click the Options menu
button - for that row, and then click Hide in Simple Mode

If you have a hidden row when viewing filter criteria in simple mode and you want to show that
row again, then in detailed mode, you must click the Options menu button - for that row, and
then click Show in Simple Mode

You can set your personal options so that report filters and Advanced Find criteria always open in
simple or detailed mode. More information: Set Personal Options

If the report offers parameters, if needed, modify the parameters and then click View

Report .

Locate data in the report.

To view or change a record, click the first field in the row for the record. A separate Microsoft
Dynamics CRM window will open with the record.

To view all records associated with a summary or chart report, click Show All at the bottom
of the report. To nav igate back to the original report, click Original Report in the report title
area.
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e To view detailed information about an area in a chart, click an area of the chart. To navigate
back to the original report, click Original Report in the report title area.

e  To page through the report, on the Report toolbar, use the Page Navigation

1 |af10 b P

buttons . To locate a specific page, type a page number in the box

and then press Enter .

e To quickly locate specific information in your report, in Find | Next , type a few characters,
and then click Find .

e To sort a column, click the column title. The direction of sorting is indicated by the
Ascending sort  button fu or the Descending sort  button .

e To view or hide the filter summary, expand or collapse Filter Summary .

e  To update your report, click the Refresh button 2.

. . . A .
e To hide the report parameters, click the Hide Parameters button #. To display the report

. N
parameters, click the Show Parameters  button ™.

Print the report. On the Report toolbar, click the Print button ﬁ
If you are working offline using Microsoft Dynamics CRM for Outlook, on the Report toolbar, select
Web archive format, click Export , and then on the File menu, click Print .

Tips

e |fachart doesn't display the first time you export a report to Web archive format, export
the report a second time.

e To print reports, you need a Reporting Services Microsoft ActiveX control. The first time you
print a Reporting Services report from either Microsoft Dynamics CRM or Microsoft Dynamics
CRM for Microsof Office Outlook, you will see a prompt Do you want to install this
software? .

To install the required control, click Install .

Export the report.

Important  The exported report is temporary. If you need to save the exported report to a local
file, use the viewing program to save the file to disk. The saved exported report is no longer
connected to Microsoft Dynamics CRM. Therefore, it does not change if Microsoft Dynamics CRM
data changes.

In the Export box, select a format, and then click Export .

A second browser window is used to display the report, using a viewer associated with the
export format you selected.

The formats that are available are determined by the rendering extensions that are installed
on the Microsoft SQL Server Reporting Services reort server, and also by whether you are
online or offline.

e If you are working offline, only the Excel and Acrobat (PDF) file formats are
available.

e |f you are using Microsoft SQL 2005 Workgroup edition, the XML file with report
data format is not available.

If a viewer is not available for the format you select, you must select a different format or
install the viewer.
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The following export formats are included in a default installation when you are online. The
list of export format s available to you may vary from those listed here.

e Excel
View the report in Microsoft Office Excel. This format includes all the row, column, and
field labels, in addition to report formatting.
Large reports and reports with charts might not display wi th the expected formatting
when exported in this file format. To export only the data, instead of using this format,
from any list in Microsoft Dynamics CRM, including results of Advanced Find searches,
export the data into Microsoft Office Excel, and then save as a commadelimited (CSV)
file. More information: Export Data to Excel

e  Web archive
View the report in Microsoft Internet Explorer, as a MIME -encoded HTML format that
keeps images and linked content together with a report. For chart reports, if the chart
is not displayed correctly the first time that you export the report, export the repo rt
again.
Choose this format to view a report offline or for e -mailing the report.

e  Acrobat (PDF) file
View the report using a client-side PDF viewer. You must have Adobe Acrobat Reader
to use this format.
Choose this format for long reports, paginated reports, or reports that are delivered as
a file.

e TIFFfile
View the report in the default TIFF viewer. For some Windows clients, this is the
Windows Pictures and Fax Viewer.
Choose this format to a view a report in a page -oriented layout. The TIFF format is the
recommended format for printing reports.

e CSV (comma delimited)
View the report as a text file, with fields separated by commas. This format includes all
the row, column, and field labels.
To export only the data, instead of using this format, export data from any list in
Microsoft Dynamics CRM, including results of Advanced Find searches, into Microsoft
Office Excel, and then save as a commadelimited (CSV) file.

e XML file with report data
View the report as an XML file.

¥ Tips

e |fthereis no report that gives you the information you need, you can either export data to Microsoft
Office Excel, or create your own report. More information: Export Data to Excel, Create and Work
with Reports

e |f a snapshot of a Reporting Services report exists, you can view it from the Reports area. To see if
any snapshots exist for a report, click the View Snapshots button F next to the report. If a
snapshot exists, click the snapshot link to view the snapshot.

Note

If multiple Language Packs are installed, only reports that are marked for display in the language you specified in
Personal Options will be visible. More information: Set Personal Options
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Manage Activities

Create or edit an activity

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. Navigate to activity records. In the Navigation Pane, click Workplace , and then under My Work click
Activities .

T ORIV
To work with activities associated with a record, open the record and then click Activities .

2. To add new activities from the Activities list, on the Actions toolbar, click New .

T ORT

To add a new activity from a record, click New Activity . You can also click the activity icons on the
Actions toolbar, or on the New menu, point to New Activity , and then select the activity type.

F Tip

iy

To quickly create a follow-up activity from a record, in the Actions toolbar, click Follow Up L= fill in the
details in the Form Assistant pane and then click Save.

3. Select an activity type, and then click OK.

4. Enter the information that you want. At a minimum, entering information in the following boxes is
useful when you or others in your organization refer to the activity at a later date:

e  Subject
Enter a meaningful description that can help you easily identify the activity in the Activities list
view. The subject field is required because, by default, most of the Activities views are sorted
by it. This field is not related to Subjects, which are the hierarchical list of categories used to
relate and organize information in Microsoft Dynamics CRM.

e  Regarding
This field is used to link the activity to another record so that you can view the activity from
the record. If you create a new activity from a record, this is automatically filled out.

e  Owner
This box represents the user who owns the activity. By default, it is set to the user who
creates the activity.

e Duration
If this activity is related to a case, make sure that you record the time you spend on the
activity in this box. If the case is linked to a cont ract line, the durations of all the activities for
this case are tallied and updated automatically in the related active contract. The total, which
includes the totals from any other cases relating to that contract, can be adjusted manually
before billing the customer. The maximum duration of an appointment or service activity is 10
days.
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e Due
Enter the date and time that the activity is expected to take place or be completed. You can
quickly sort on the Due field when you view activities.

F Tip

To automatically update the Regarding field with information from a record, click the Expand button @
in the right pane to open the Form Assistant pane and then select a record.

5. Some activities also have the following optional fields:

e  Sender
You can use this field to record the user in your organization who initiated an outgoing
communication. Alternatively, if this is an incoming communication from a customer, you can
select the lead, account, or contact who initiates the communication. The s ender must be a
valid Microsoft Dynamics CRM account, contact, or lead, but can also be a Microsoft Dynamics
CRM user. By default, this box contains the name of the user who creates the activity.

e  Recipient
This is the person, typically an account, contact, lead, or Microsoft Dynamics CRM user, that
receives the communication.

e Category , Sub-Category
You can use these text fields to categorize tasks so that you can sort or view your tasks by
category and/or sub-category.

6. Click Save or Save and Close .

F Tip

If you are using the activity to track something that has already been completed, on the File menu, click
Save as Completed

Notes

® To create the same activity for multiple records, use a quick campaign. More information: Work with
Quick Campaigns

e You cannot edit multiple activities at once.

e You cannot schedule recurring activities.

® You cannot edit closed activities.

® You cannot change one activity into another type of activity.

® You cannot set reminders in Microsoft Dynamics CRM for Microsoft Offce Outlook for faxes, phone
calls, e-mails, letters, or campaign responses activities created in the Web application or Microsoft
Dynamics CRM for Outlook

e When the duration of an activity is more than 60 minutes (an hour), the time you enter is converte d
into hours. When the activity is saved, the value is rounded up and might change from the entry
that was originally displayed when it was converted from minutes into hours. Note that rounding is
only observed on the hundredth of an hour. The exact value for the duration, however, is stored in

Microsoft Dynamics CRM4.0 User 6s Gui de 29



the database in minutes, and this value is used to calculate the total billing time when resolving
cases.

e The letter and fax activities record when the letter or fax is sent or received. When you create the
activity, you attach the letter or fax document, such as a Microsoft Office Word file, to the record.
With the mail merge feature, you can write your letter and include Microsoft Dynamics CRM data.
More information: Create CustomerReady Documents and Messages

Create and send an e - mail activity in the Web application

F Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: E-mail Permissions

You can create and send e-mail activities from Microsoft Dynamics CRM from the Activities area. Email messages sent
from Microsoft Dynamics CRM do not appear in the Microsoft Dynamics CRM mail folders inOutlook.

1. Start Microsoft Dynamics CRM4.0.

2. In the Navigation Pane, click Workplace , and then click Activities .
3. On the Actions toolbar, click New .

4. In the New Activity dialog box, click E-mail , and then click OK.

5. On the E-mail tab, you must enter the following in formation.

(] From
Locate and select the sender's name.

e To
Locate and select one or more recipients. You can select a record from a filtered list in the

Form Assistant paneg or you can click the Lookup button @I to search for other records.

e  Subject
Type a subject for your e-mail message.

e Duration
This field is not required, but if you are tracking the amount of time spent on cases, and this
message is related to a case, enter the amount of time spent on this message.

e Due
If you are not sending yo ur e-mail message immediately, enter a date to complete and send
the message. The message is not sent automatically.

e  Enter any additional information you want. Use the Formatting toolbar
You cannot enter HTML tags or insert images into the body text of t he message.

F Tip

® You can copy and paste content from Microsoft Office Word. This lets you take advantage of
features such as spelling check and some text formatting. If your text is double -spaced, you
can press SHIFT+ENTER to singlespace lines of text.

® You can include animage if the file is hosted on a public Web site. Use the copy and paste
feature of Microsoft Internet Explorer to include a link to the image in the message. The image
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is displayed as long as the receipient has access to the Web site.

6. You can also attach an article, template, or file to an e -mail activity.
F To attach an article

a. Tolook up and select an article, on the Formatting toolbar, click Insert KB Article
b. Use the Search tab to specify conditions or criteria to locate the article.

c. Inthe results list, select the article, and then click OK.
The article appears the body of in your e -mail message.

d. Type any additional text, or edit the article.

F To attach an e-mail template

a. Tolook up and select an e-mail template, click Insert T emplate .

b. Onthe Insert Template dialog box, select the template you want to use. You can either use
a global template, or a template specific to the record type you selected as the recipient. For
example, account or customer.

c. ClickOK.
The template appears in the body of your e -mail message and the subject line is updated with
the subject line of the template.

d. Type any additional text or edit the text provided. Editing the text or subject line in the
message does not change the template.

F To attach a file

a. Save the activity.
b. On the Attachments tab, click New E -mail Attachment

c. Inthe Add Attachment dialog box, in the File Name box, type the name of the file, or click
Browse to locate the file that you want to attach.

d. Click Attach .

To send the message immediately, click Send .
The message is sent and the new closed activity appears in the History area with an assigned
message number appended to the Subject column and the date sent in the Actual End column.

1T ORT
To send the message at a later time, click Save and Close . The new draft activity appears in the

Activities area. You can delete draft messages.

To send the message, in the list of activities, open the e -mail activity, and click Send .

Important

After you save your e-mail message as a Microsoft Dynamics CRM email activity, the saved message can be accessed
by anyone who has access to your activities in Microsoft Dynamics CRM.
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Notes

e You can view the sent date of an e-mail message on the Activitie s list. The Actual End Date is the
date the message was sent and closed.

e You can forward or reply to an e -mail activity, but you cannot resend it.
To reply to only the original sender, on the Actions toolbar, click Reply .
To reply to the original sender and to send copies to everyone who originally received the message,
click Reply All .
To forward the e-mail activity to new recipients, click Forward , and then select new recipients.

e There is no spelling checker built into Microsoft Dynamics CRM. There may be third-party solutions
available. For more information, visit Microsoft Dynamics CRM Solution Finder

Close an activity

F Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

b Activity types that can be closed

e Tasks
e Faxes
e  Phone Calls
e Letters
e  Appointments
e  Service Activities
e  Campaign Activities
Unless you have created an activity record by mistake, it is better to close or convert an activity than to delete it. You

can view closed or converted activities at a later date for referenc e, or run reports to determine the success rate of
your activities.

1. Navigate to activity records. In the Navigation Pane, click Workplace , and then under My Work click
Activities .

T ORI
To work with activities associated with a record, open the record and then click Activities .

2. Open the activity that you want.

3. On the Actions " menu, click Close activity type. For example, if you are in a task record, click
Close Task .

4. In the confirmation dialog box, select the status that you want from the Status list, such as
Completed or Canceled , and then click OK.

32 Microsoft Dynamics CRM4.0 User 6s Gui de


http://go.microsoft.com/fwlink/?LinkId=98752

Notes

e When you close an activity, the activity becomes read-only and cannot be edited or reopened.
e To view closed activities, do one of the following:

O Inthe Activities list, select the Closed Activities view.

0 Use Advanced Find, and specifyActivity Status  in the search criteria.

0 From an Account, Contact, Lead, or Opportunity record, under Details , click History . In the
Filter on and Include lists, select the view options that you want.

e |tis not possible to close multiple activities at once.

The only way to close an e-mail activity is to send it. If you do not use Microsoft Dynamics CRM to
send or receive e-mail, click Send . This will close the activity, but no e -mail message will be sent.

Convert an activity to an opportunity

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

k Activity types that can be converted

e Faxes

e  Phone Calls

e E-mail Messages
e letters

e  Appointments

1. Navigate to activity records. In the Navigation Pane, click Workplace , and then under My Work click
Activities .

T ORI
To work with activities associated with a record, open the record and then click Activities .

2. Open the activity that you want.
3. On the Actions toolbar, click Convert Activity , and then click To Opportunity
4. In the Convert Activity to Opportunity dialog box, enter information in the following boxes:
e  Customer
You must click the Lookup button @I to select or create a new customer.

e  Source Campaign
Click Lookup if you want to associate a source campaign with this activity.
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e  More Actions

By default, Microsoft Dynamics CRM automatically completes the following operations during
the conversion.

0 Close the activity as completed.
0 Open the new opportunity after the conversion.

0 Create a campaign response based on the information included in the opportunity.
Important  If you are converting an activity to an opportunity that is not associated

with a Source Campaign, you must clear the Record a closed campaign response
check box.

To change the conversion operations, clear the associated check boxes.

5. Inthe Convert Activity to Opportunity dialog box, click OK.

6. Click Save or Save and Close .

Note

The originating activity becomes a related activity for the new opportunity. If the activity is open, it appears in the
Activities list for the opportunity. If the activity is closed, it appears in the History list.

Convert an activity to a case

k Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. Navigate to activity records. In the Navigation Pane, click Workplace , and then under My Work click
Activities .

T ORI
To work with activities associated with a record, open the record and then click Activities .

2. Open the activity that you want.

b Activity types that can be converted

e Faxes

e  Phone Calls

e E-mail Messages
e Letters

e  Appointments

3. On the Actions toolbar, point to Convert Activity —and then to Case.

4. In the Convert Activity to Case  dialog box, enter information in the following boxes:
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e  Customer
You must click the Lookup button @I to select or create a new customer.

e By default, Microsoft Dynamics CRM automatically completes the following operations during
the conversion:

0 Close the activity as completed.

0 Open the new case after the conversion.
To change the conversion operations, clear the associated check boxes.
5. In the Convert Activity to Case dialog box, click OK.

Note

The originating activity becomes a related activity for the new case. If the activity is open, it appears in the Activities
list for the case. If the activity is closed, it appears in the History list.

Convertane -mailto alead

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. Navigate to activity records. In the Navigation Pane, click Workplace , and then under My Work click
Activities .

T ORI
To work with activities associated with a record, open the record and then click Activities .

2. Open the e-mail activity that you want to convert.
3. On the Actions toolbar, point to Convert Activity and thento To Lead .
4. In the Convert E -mail to Lead dialog box, enter information in the following boxes:
e  First Name
e Last Name
e  Company
e  E-mail Address

e By default, Microsoft Dynamics CRM automatically completes the following operations during
the conversion:

0 Open the new lead after the conversion, if all the required information for the lead is
available. Otherwise this option is not available.

O Close the e-mail form.
To change the conversion operations, clear the associated check boxes.
5. Click OK.
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Notes

e The originating activity becomes a related activity for the new lead. If the activity is open, it appears in
the Activities list for the case. If the activity is closed, it appears in the History list.

e The icon in the Activities list changes.

Assign an  activity to a user or queue

F Can I do this task?

If the Assign button &’ is not visible on the toolbar, the security role assigned to your account does
not have permission to assign this type of record. To check your permissions for a specific record, open

-

the record, click the File menu button * j, and then click Properties .

More information about specific permissions and performing this task while offline: Common Task
Permissions

1. Navigate to activity records. In the Navigation Pane, click Workplace , and then under My Work click
Activities .

T ORT
To work with activities associated with a record, open the record and then click Activities .
2. In the list of records, select the record that you want.

F Or, select multiple records

e  Select several records by pressing the CTRL key while you click each record.

e Select a sequence of records by clicking the first record that you want, and then press the SHIFT
key while you select the last record that you want.

e  Select all records on the page by selecting the Select/clear all records on this page check box
at the top of the list.

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 records per page:

4. Onthe Tools menu, click Options .

5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.
6. ClickOK.

This changes the number of items that is displayed for all lists, which may slow response time when you
switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

On the Actions toolbar, click the Assign button %’
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In the Assign to Queue or User  dialog box, type all or part of the queue or user name,

and then click the Lookup button @I

In the Look Up Records dialog box, in the Look for list, select the type of record you want
to find.

In th e Search for records  box, type the first few letters of the name of the record to

narrow your search, and then click the Find button EI
In the list of records, click a record to select it, click the Add Selected Records
button to add the record to the Selected records list, and then click OK.

On the User or Queues form, click OK.

Add a Note or Attach a File

Add, edit, or delete a note

F Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

F Record types that you can add notes to

e  Accounts

e  Appointments

e  Campaigns

e  Campaign Responses
e Cases

e  Competitors

e Contacts

e  Contracts

e Faxes
e |eads
. Letters

e  Marketing Lists
e  Opportunities

e  Phone Calls

e  Products

e  Service Activities

e Tasks

1. Open the record that you want.
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2. For most record types, click the Notes tab.
e  On the E-mail form, click the Attachments tab.
e On the Service Activity form, click the Service Activity tab.

e  On the Case form, click the Notes and Article tab.
3. To add a note, click Click here to enter a new note

T ORT

To open and edit a note, double-click the status row above the note, or right -click the note and then
click Open.
4. In the Note form, you can make changes to the following boxes:

e Title
Change the title of the note. Titles must have a length of 64 characters or less. Titles are no t
displayed in the notes list.

e Note content
Add, remove, or edit the note content.

e Regarding
You can use this item to open and make changes to the activity or record that this note is
associated with.

e  File Attachment  section
Add or remove a file attachment. In the File Name box, type the name of the file, or click
Browse to locate the file that you want to attach, and then click Attach .

F Tips

e  Each note can have only one attached file, so if you need to attach multiple files, create a note for
each file.

e  The maximum size of the file that you can attach to a record is defined by your system
administrator. More information: System Settings DialogBox - E-mail Tab

5. Click Save or Save and Close .
¥ Tips

e To paste text from the Clipboard into a note, open the note, and then press CTRL+V.
e To use atab in a note, copy the text from a file that includes the tab, and then use CTRL+V to paste
the text into the note.

Note

To delete a note, double-click the status row of the note to open it, and then on the Actions L menu, click Delete
Note . If you do not have appropriate permissions to delete any of the records associated with the note, you will not be
able to delete it.
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Attach a file

F Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. Open the record that you want.

2. On the Actions toolbar, click the Attach a File button @ .

3. Inthe Add Attachment dialog box, type the path and name of the file to attach or click Browse to
locate the file.

4. Click Attach , and then click Close.
The attachment is added as a note.

5. Click Save or Save and Close .

Notes

e To add multiple files, for each file, repeat steps 2 through 4. Each attachment is added as a new note.

e You cannot update an attached file. Instead, save the file on your computer and edit the file, delete
the attachment, and then attach the edited file.

e To add an attachment to an e -mail activity, first save the activity, and then on the Attachments tab,
click New E -mail Attachment . After selecting or browsing for a file, click Attach .

e The maximum size of the file that you can attach to a record is defined by your system administrator.
More information: System Settings Dialog Box- E-mail Tab

® The types of files that can be attached are defined by your system administrator. More information:
Manage System Settings

Remove an attached file

F Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. Open the record that you want.

2. For most record types, click the Notes tab.
e On the E-mail form, click the Attachments tab.
e On the Service Activity form, click the Service Activity tab.

e  On the Case form, click the Notes and Article tab.
3. Double-click the status row of the note that con tains the attachment you want to remove.

4. To keep the note, but remove the attachment, in the Note form, in the File Attachment area, click
Remove , click OK, and then click OK again.
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T ORI

To remove the note and the attachment, on the Actions “ menu, click Delete Note , and then
click OK.

5. Click Save or Save and Close .

Note
You cannot update an attached file. Instead, save the file on your computer and edit the file, delete the attachment,

and then attach the edited file.

Edit Multiple Records

Caution When you edit or delete multiple records, you cannot undo the changes.

Edit multiple records

F Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

¥ Record types that can be bulk edited

e  Accounts

e Cases

e Contacts

e |leads

e  Marketing Lists

e  Opportunities

1. In any list, select multiple records:
e  Select several records by pressing the CTRL key while you click each record.

e  Select a sequence of records by clicking the first record that you want, and then press the
SHIFT key while you select the last record that you want.

e  Select all records on the page by selecting the Select/clear all records on this page check
box at the to p of the list.

F Tip

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 records per page:

4. Onthe Tools menu, click Options .
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5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.
6. Click OK.

This changes the number of items that is displayed for all lists, which may slow response time when you
switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

On the Actions toolbar, click More Actions , and then click Edit .

In the Edit Multiple Records  form, make the changes that you want.
Any fields that you enter data in will change in all selected records. Other fields will be left
unchanged.

Click Save.

Notes

e You cannot perform a multiple edit operation on activities, lookup fields, or notes.
e You cannot use this form to clear data in a field.

e You cannot use this form to change the status of records. However, to change the status for a group
of leads, add them to a marketing list. More information: Work with Marketing Lists

Delete records

F Can | do this task?

If the Delete button X is not visible on the toolbar, the security role assigned to your account does
not have permission to delete this type of record. To check your permissions for a specific record, open

the record, click the File menu button '“-"f:, and then click Properties .

If you are deleting a record that has child records, you can delete it only if you also have permission to
delete any child records.

More information about specific permissions and performing this task while offline: Common Task
Permissions

1. In any list of records, select the record that you want to delete.

T ORT
In any list, select multiple records:

e  Select several records by pressing the CTRL key while you click each record.

e  Select a sequence of records by clicking the first record that you want, and then press the
SHIFT key while you select the last record that you want.

e  Select all records on the page by selecting the Select/clear all records on this page check
box at the top of the list.
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F Tip

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To

display up to a maximum of 250 records per page:

4. Onthe Tools menu, click Options .
5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.
6. ClickOK.
This changes the number of items that is displayed for all lists, which may slow response time when you
switch record types. Therefore, you might want to set it back to a smaller number when you are done with

this bulk action.

On the Actions toolbar, click the Delete button X
If you are deleting accounts or contacts, you have the option to deactivate the record

instead of deleting it. In the Delete Confirmation  dialog box, to delete the record, click Delete ,

or to deactivate it, click Deactivate .

For other record types, in the Confirm Deletion dialog box, click OK.

Notes

e \When you delete a record, all its relationships to other records are also deleted.
e |f the record has child records, and you have permission to delete the child records, the child records

will also be deleted.
Check for Duplicates

Search for potential duplicate records
F Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings and if at

least one duplicate-detection rule exists for the record type.

1. Start duplicate detection:

F Start duplicate detection from any list of records, including results of an Advanced Find search

a. Inany list, on the More Actions menu, click Detect Duplicates

b. To search selected records, clickFor Selected Records

T ORT
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To search all records on all pages of the current view, click For All Records on All Pages

F Start duplicate detection from the Workplace, Tools menu, or Settings area

a. Onthe Tools menu, click Duplicate Detection

T ORT
In the Workplace , in the My Work section, click Duplicate Detection , and then click New .
T ORT

In the Navigation Pane, click Settings , click Data Management |, click Duplicate Detection
Jobs, and then click New .

b. Click Next .

c. To specify the record type to check for duplicates, in the Look for box, select a record type.
Only record types that have published duplicate-detection rules will be included in the Look for
box. More information: Work with Duplicate-detection Rules

d. Select criteria to define the records to check for duplicates:

e  To use criteria from a saved view, in the Use Saved View box, select a view from the
System Views or My Views section.

T ORI
For each criteria to add, click Select . More information: Work with Advanced Find

e. Tips:
e To preview the records to make sure you have the records you want, click Preview
Records .

e To change which columns are displayed in the preview, or the column order, sort order, or
column widths, click Edit Columns .

e To save these criteria to use later, click Save As. This saves the criteria as a saved view.
This saved view will be available in the My Views section of the View box.

f.  Click Next .

3. Specify:
e  The name of the duplicate-detection job.

e  When you want the duplicate -detection job to start. You also can specify to run the job on a
regular schedule.

e  Whether you want notification sent to you and to other users when the background
duplicate-detection job completes.

Click OK, or click Finish .
Duplicate-detection is processed in the background. If you requested notification, you will receive an
e-mail notification when the job completes, with a link to the page where you can resolve
duplicates.
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To view the potential duplicates, after the duplicate -detection job completes, in the
Workplace , under My Work , click Duplicate Detection

Open your duplicate-detection job.

Under Details , click View Duplicates

The top list displays all records that have potential duplicates. When you select a record in the top
list, the bottom list shows all the potential duplicate records.

In the top list of records that ma y have duplicates, select a record.

In the list of potential duplicate records, for each potential duplicate record found, select the
record, and then do any of the following actions:

e Viewtherecord. To view the contents of a record to help you decide w hat to do, double -
click the record.

e Edittherecord. On the Actions toolbar, click More Actions , and then click Edit .

e Deactivate the record. On the Actions toolbar, click More Actions , click Deactivate , and
then in the confirmation dialog box, click OK.

e  Merge the records. On the Actions toolbar click the Merge button - |

If you want the record in the top list to be the master record, click Automatically

T ORT
If you want to choose the master record:

1. ClickSelect Master .

2. Inthe Merge Records dialog box, select which record to make the new master
record.

3. Select the fields from each record that you want to include in the master record. Fields
that are shaded will overwrite the corresponding unshaded field during the merge
operation.

4. When you are ready to merge the two records, click OK.

When you receive the message The selected records are merged and the subordinate
record is deactivated |, click OK.

e Delete therecord. On the Actions toolbar, click the Delete button x In the Select
Delete or Deactivate dialog box, click Delete , and then in the confirmation dialog box,
click OK.

When you have finished resolving duplicates, click Close.

Notes

e Your system administrator or system customizer determines the criteria for identifying a record as a
potential duplicate. More information: Requesting User Interface Changes

e |f you enter a duplicate record within a few minutes of entering the first record, Microsoft Dynamics
CRM will not detect the duplicate record. The matchcodes for new and updated records are created
every five minutes, rather than as a record is created.

e To refresh the list of duplicate records, you must run a new duplicate -detection job:

O  After arecord has been merged or deactivated, the record is still displayed on the bottom list.
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0 You can use the Modified On column to determine whether a record was modified after the
duplicate-detection job was run.

O After arecord has been deleted, merged or deactivated, the record is still displayed on the
top list.

Merge records

F Can I do this task?

This task requires permissions that are found in all default security roles. More information about
specific permissions and performing this task while offline: Common Task Permissions

You can merge two lead, account, or contact records.

1. Click to select a record, and then press the CTRL key while you click the second record.

2. On the Actions toolbar click the Merge button s,
3. If you want the record in the top list to be the master record, click Automatically

T ORIV
If you want to choose the master record:

a. Click Select Master .
b. Inthe Merge Records dialog box, select which record to make the new master record.

c. Select the fields from each record that you want to include in the master record. Fields that
are shaded will overwrite the corresponding unshaded field during the merge operation.

d.  When you are ready to merge the two records, click OK.

4. When you receive the message The selected records are merged and the subordinate record
is deactivated , click OK.

Check Your Permissions for a Record
View your permissions for a record

1. In the list of records, open the record that you want.

2. Click the File menu button '-".{:, and then click Properties .

F Tip
If you do not have permissions that you need to do your job, contact your manager. More information: Requesting User
Interface Changes
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View your user profile

F Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

Your user profile displays information about you, including general information such as your contact information and
addresses, what teams and resource groups you belong to, which services you can perform, and your work hours and
security roles. This information is visible to the entire organization. Depending on your security role, you may be able
to make changes to your user profile.

If you are working in Microsoft Dynamics CRM for Outlook, you can view this infor mation from the User form. More
information: Work with Your User Record and Work Hours

1. Under Workplace , click the Personalize Workplace  link.
2. Inthe Set Personal Options dialog box, click the General tab.

3. At the bottom of the page, click the View your user profile here link.
The User form with your information opens.

4. To view details or make changes, under Details or Service click any of the following:

e Teams
e Roles
e  Quotas

e  Work Hours
e  Services
e  Resource groups
e  Workflows
5. To close the form, on the File menu, click Close.

6. To close the Set Personal Options  dialog box, click OK.

Start an On - Demand Workflow

If you or your organization have created on -demand workflows, you can apply these workflows to records that appear
in a list.

Start an on  -demand workflow

F Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. Open the list of records that contains the record you want to apply a workflow to, such as leads or
cases.
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2. Select the record or records that you want to apply a workflow to.
3. On the Actions toolbar, click Run Workflow
4. In the Look Up Records dialog box, select the workflow that you want to run, and then click OK.

5. In the confirmation message, click OK.

Note

The Run Workflow button does not appear on the Actions toolbar if no on -demand workflows have been created for
the record type that you are viewing.

Sharing Records with Coworkers

Share or Assign Records

When you share a record with another user, you are giving that user specific permissions, such as Read, Write, or
Delete, to that record. When you assign a record to another user, you are making that user the owner of the record.

Share a record

F Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

F Record types that can be shared

e  Accounts

e Cases

e  Campaigns

e Contacts

e  Contracts

e Invoices

e |leads

e  Marketing Lists

e  Opportunities

e  Orders
®  Quotes
e  Reports

1. In the list of records, select the record that you want.

F Or, select multiple records

e  Select several records by pressing the CTRL key while you click each record.
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e  Select a sequence of records by clicking the first record that you want, and then press the SHIFT
key while you select the last record that you want.

e Select all records on the page by selecting the Select/clear all records on this page check box
at the top of the list.

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 records per page:

4. Onthe Tools menu, click Options .

5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.
6. Click OK.

This changes the number of items that is displayed for all lists, which may slow response time when you
switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

On the Actions toolbar, click More Actions , and then click Sharing .
In the sharing dialog box, under Common Tasks , click Add User/Team

In the Look Up Records dialog box, in the Look for list, select the type of record you want
to find.

In the Search for records  box, type the first few letters of the name of the record to
narrow your search, and then click the Find button EI

In the list of available records, click a user or team to select it, and then click the Add
Selected Records button to add the user or te am to the Selected records list.

Repeat step 6 to add more users or teams.

Click OK.

In the sharing dialog box, select the type of share access that you want. The available
permissions are: Read, Write, Delete, Append, Assign, or Share.

Click OK.

F Tips

® To see records that have been shared with you, use Advanced Find to create a saved view that
includes the owner column. If you can access the record, but are not the owner, it has been shared
with you.

e |f you want to limit the permissions on a record you own, you can share the record with yourself.
Then, you can limit the permissions on the record. For example, if you clear the delete permission
on a record, you will not be able to delete that record.

Notes

e To cancel any changes that you have made and retain the previous permissions settings, click Reset .

® To select or clear all permissions on a selected item, click Toggle All Permissions of the Selected
Items .

48 Microsoft Dynamics CRM4.0 User 6s Gui de



® You cannot create a new contact or account that is shared by default.

e When you share a record, the user with whom you share the record inherits the privileges on certain
associated records. For example, when you share a contact, the user is also granted the same
privileges on the parent account. To prevent privileges from cascading, a user wit h the appropriate
security role can change this behavior by customizing the relationship definition for the record type.
More information: Work with Entities

Unshare or change sharing for a record

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. In the list of records, select the record that you want.

F Or, select multiple records

e  Select several records by pressing the CTRL key while you click each record.

e  Select a sequence of records by clicking the first record that you want, and then press the SHIFT
key while you select the last record that you want.

e  Select all records on the page by selecting the Select/clear all records on this page check box
at the to p of the list.

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 r ecords per page:

4. Onthe Tools menu, click Options .

5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.
6. ClickOK.

This changes the number of items that is displayed for all lists, which may slow response time when you
switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

On the Actions toolbar, click More Actions , and then click Sharing .

To remove a user or team, in the row for the user or team whose rights you want to change,
select the check box, and then under Common Tasks click Remove Selected Items

i ORI

To edit permissions on a record for a user or team, select or clear one or mo re permissions check
boxes, such asRead or Delete .

Click OK.

Notes
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e To cancel any changes that you have made and retain the previous permission settings, click Reset .

e To select or clear all permissions on a selected item, click Toggle All Permissions of  the Selected
Items .

Assign a record to a user

k' Can | do this task?

If the Assign button &’ is not visible on the toolbar, the security role assigned to your account does
not have permission to assign this type of record. To check your permissions for a specific record, open

el

the record, click the File menu button , and then click Properties .

More information about specific permissions and performing this task while offline: Common Task
Permissions

1. In the list of records, select the record that you want.

b Or, select multiple records

e  Select several records by pressing the CTRL key while you click each record.

e  Select a sequence of records by clicking the first record that you want, and then press the SHIFT
key while you select the last record that you want.

e  Select all records on the page by selecting the Select/clear all records on this page check box
at the top of the list.

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 records per page:

4. Onthe Tools menu, click Options .

5. Onthe General tab, inthe Records Per Page list, select the number of records to display
per page.
6. ClickOK.

This changes the number of items that is displayed for all lists, which may slow response time when you
switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

On the Actions toolbar, click the Assign button %’

In the Assign dialog box, click:

e  Assignto me
Use this option to assign the record to yourself.

i ORI
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e  Assign to another user

Click the Lookup button @I type a part of the user's name, click the Find button EI
double-click the user's name, and then to close Look Up Records dialog box, click OK.

Click OK.
F Tips
® You can create your own Advanced Find view that includes records belonging to users to whom you

normally assign records.

° sﬁ?lf you have a security role with appropriate permissions, you can reassign all records belonging to
one user to another user.

1. Inthe Navigation Pane, click Settings , click Administration , and then click Users.

2. Open the record for the user whose records you want to reassign.

3. Onthe Actions “& menu, click Reassign Records , and then click Assign to another
user.

4. Click the Lookup button @I type a part of the user's name, click the Find button EI
double-click the user's name, and then to close Look Up Records dialog box, click OK.

Notes

e You cannot assign records to teams. To give a team access to a record, share the record with the
team.

e Your system administrator may have enabled reassigned records to be automatically shared with the
original owner. More information: Manage System Settirgs

Assign an activity to a user or queue

k' Can | do this task?

If the Assign button &’ is not visible on the toolbar, the security role assigned to your account does
not have permission to assign this type of record. To check your permissions for a specific record, open

=

the record, click the File menu button , and then click Properties .

More information about specific permissions and performing this task while offline: Common Task
Permissions

1. Navigate to activity records. In the Navigation Pane, click Workplace , and then under My Work click
Activities .

T ORI
To work with activities associated with a record, open the record and then click Activities

2. In the list of records, select the record that you want.
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F Or, select multiple records

e  Select several records by pressing the CTRL key while you click each record.

e  Select a sequence of records by clicking the first record that you want, and then press the SHIFT
key while you select the last record that you want.

e  Select all records on the page by selecting the Select/clear all records on this page check box
at the top of the list.

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 records per page:

4. Onthe Tools menu, click Options .

5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.
6. ClickOK.

This changes the number of items that is displayed for all lists, which may slow response time when you
switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

On the Actions toolbar, click the Assign button &’
In the Assign to Queue or User  dialog box, type all or part of the queue or user name,
and then click the Lookup button @I

In the Look Up Records dialog box, in the Look for list, select the type of record you want
to find.

In th e Search for records  box, type the first few letters of the name of the record to
narrow your search, and then click the Find button EI

In the list of records, click a record to select it, click the Add Selected Records
button to add the record to the Selected records list, and then click OK.

On the User or Queues form, click OK.

Assign a case to a user or queue

k' Can | do this task?

This task requires permissions that are found in all default service security roles. More information about
specific permissions and performing this task while offline: Service Permissions

After a case is created, it can be assigned to another user or to a queue. After accepting a case, the assigned user
can continue working with the customer.

1. In the Navigation Pane, click Service , and then click Cases.

2. In the list of cases, select the case you want to assign.
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F Or, select multiple records

e  Select several records by pressing the CTRL key while you click each record.

e  Select a sequence of records by clicking the first record that you want, and then press the SHIFT
key while you select the last record that you want.

e  Select all records on the page by selecting the Select/clear all records on this page check box
at the top of the list.

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 records per page:

4. Onthe Tools menu, click Options .

5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.
6. ClickOK.

This changes the number of items that is displayed for all lists, which may slow response time when you

switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

On the Actions toolbar, click the Assign button &’

In the Assign to Queue or User  dialog box, to assign the case to another user or queue,
select Assign to another user or queue

Then to select a record, click the Lookup button @I
Click OK.

Note

After a case is assigned to a queue, it is displayed in the Queues area. If it was assigned to a user, it will appear in his
or her Assigned area. An assigned case belongs to the user who created it until it is accepted by another user.

Make a report available to all Microsoft Dynamics CRM users

k- Can I do this task?

This task requires the System Administrator or System Customizersecurity role or equivalent
permissions. More information about specific permissions and performing this task while offline: Report
Permissions

1. In the Navigation Pane, click Workplace , and then under My Work , click Reports .

2. Select the report you created, and on the Actions toolbar, click Edit Report .

3. On the Actions 22 menu, click Make Report Available to Organization

Note

To revert a report back to a personal report, on the Actions % menu, click Revert to Personal Report
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Send or Copy a Shortcut

Only another Microsoft Dynamics CRM user who has permission to see the view or the record will be able to open the
record.

Send or copy a shortcut to a record

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

You can send a shortcut to a specific record or group of selected records in Microsoft Dynamics CRM in an email
message to any user.

This feature does not use Microsoft Dynamics CRM email; it uses your default Microsoft Internet Explorer e -mail. If
the person receiving the e-mail does not have permissions to the view, they will receive an error. Not all views are
available. No activity is created for this action.

You can also copy the shortcut and paste it into any document.

1. In the list of records, select the record that you want.

F Or, select multiple records

e  Select several records by pressing the CTRL key while you click each record.

e  Select a sequence of records by clicking the first record that you want, and then press the SHIFT
key while you select the last record that you want.

e  Select all records on the page by selecting the Select/clear all records on this page check box
at the to p of the list.

By default, the Microsoft Dynamics CRMWeb application displays 50 records per page. You can increase
the number of records displayed and thereby increase the number of records you can select at one time. To
display up to a maximum of 250 r ecords per page:

4. Onthe Tools menu, click Options .

5. Onthe General tab, in the Records Per Page list, select the number of records to display
per page.

6. ClickOK.

This changes the number of items that is displayed for all lists, which may slow response time when you

switch record types. Therefore, you might want to set it back to a smaller number when you are done with
this bulk action.

Do one of the following:

k' Send a shortcut in an e-mail

On the Actions toolbar, click Send Shortcut , and then click Of Selected Item

a. Complete the e-mail form and send.

Tip: If you are working in Microsoft Dynamics CRM for Outlook and you want to track this e -mail, you can
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use Track in CRM .

k' Copy a shortcut

On the Actions toolbar, click Copy Shortcut , and then click Of Selected Item

a. Paste the shortcut into any application that supports copy and paste. For example, in Microsoft
Office Word, press CTRL+V.

Important

The shortcut is not a snapshot of the data, but a link to the live data.

Send or copy a shortcut to a view

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

You can send a shortcut to a specific saved view in Microsoft Dynamics CRM in an email message to any user.

This feature does not use Microsoft Dynamics CRM email; it uses your default Microsoft Internet Explorer e -mail. If
the person receiving the e-mail does not have permissions to the view, they will receive an error. Not all views are
available. No activity is created for this action.

You can also copy the shortcut and paste it into any document.

k' Pages that you cannot e-mail or copy

e  Contract Template list

e  Article list

e |n any available, saved view, do one of the following:
F Send a shortcut in an e-mail

a. On the Actions toolbar, click Send Shortcut , and then click Of Current View
b. Complete the e-mail form and send.

Tip: If you are working in Microsoft Dynamics CRM for Outlook and you want to track this e -mail, you can
use Track in CRM .

k' Copy a shortcut

a. On the Actions toolbar, click Copy Shortcut , and then click Of Current View

b. Paste the shortcut into any application that supports copy and paste. For example, in Microsoft
Office Word, press CTRL+V.

Important
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The shortcut is not a snapshot of the data, but a link to the live data.

Export Data to Excel

You can export any list to Microsoft Office Excel, including the results of an Advanced Find search.

You can export to a static or dynamic Excel worksheet or to a PivotTable.

Export data to an Excel static worksheet

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

56

1. In any area with a list of records, select the columns to include in the exported list.
By default, an exported worksheet includes the fields that are displayed in the list, using the same
field order, sorting, and field widths.

To make changes to the columns in an Advanced Find View, clickEdit Columns . You can make the
following types of changes:

k' Change the column order

To change the column order, select a column heading, such as Account Name , and then under Common

Tasks, click the Move Left button e or the Move Right button e to move the column.

F Add columns

a. Toadd columns to the export list, click Add Columns .

b. To add columns for the main record type, select it, and then in the Add Columns list, click to
select fields that you want to add as columns.

c. To add columns from related records, first select the related record type, and then in the Add
Columns list, click to select fields that you want to add as columns.

d. ClickOK.

k- Configure sorting

To change the sort order, click Configure Sorting , in the Column list, select the column that you want to
sort, in the Order area, click Ascending Order or click Descending Order , and then click OK.
You cannot sort on columns from related record types.

k' Change column width

To change the column width that will appear in the Excel worksheet, select a column heading, such as
Account Name , click Change Properties . Inthe Change Column Properties  dialog box, select the
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width (in pixels) that you want, and then click OK.

k' Remove columns

To remove a column, select the column heading that you want to remove, and under Common Tasks ,
click Remove , and then in the confirmation message, click OK.

You cannot change the columns for a system view, such as All Active Accounts . You must either
customize the view, which requires the System Administrator or System Customizer security role, or
use Advanced Find to create your own view based on the current view. To create your own view,
with the system view open, click Advanced Fin d.

2. On the Actions toolbar, click the Export to Excel button L"il
3. Inthe Export Data to Excel dialog box, select Static worksheet with records from this page
i ORi

Select Static worksheet with records from all pages in the current view .
This option will be visible only when your view includes more than one page of records.

4. Click Export .

5. To view the static worksheet, click Open.
If you are using Microsoft Office Excel 2007, you will see a message that says the file you are trying
open is in a different format than specified by the file extension. Click Yes.

6. To save the exported data to a file, in Excel, on the File menu, click Save.

F Tip

You can e-mail a static exported worksheet to anyone, or store it in a shared file. Anyone who opens the file will see all
the data in the file, whether or not they are a Microsoft Dynamics CRM user or have privileges to view the data in
Microsoft Dynamics CRM.

Notes

e There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel
2003 comma-separated value (CSV) file.

To ensure that the file is exported correctly, you must have data in every row of the last column of
the list you are exporting. You can add a space or other character in last column of the file or
reorder the columns so that the last column always contains data. More information: Microsoft
Knowledge Base Article 77295

e By default, in Microsoft Dynamics CRM, you cannot export a list of more than 10,000 records at a time
to a static Excel worksheet. Your system administrator can change this. More information: Microsoft
Knowledge Base Article 911395

e By default, Microsoft Dynamics CRM lists up to 50 records per page. If there is more than one page of
records available to view in the list of records, use the Page arrows at the bottom of the list to view
the additional pages.
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Export data to an Excel PivotTable

1. In any area with a list of records, on the Actions toolbar, click the Export to Excel button L‘gl
2. Click Dynamic PivotTable

3. To add or remove a column in the report, click Select Columns .

4

. In the Select PivotTable Columns list, select or clear the check boxes for the fields as needed, and
then click OK.

By default, only fields that are displayed in the Select PivotTable Columns list are included in the
PivotTable Field List.

[6)]

. Click Export .

(o]

. Open the file containing the PivotTable:
a. To view the PivotTable, click Open.
b. If you are using Microsoft Office Excel 2003, click Enable automatic refresh

T ORIV
If you are using Microsoft Office Excel 2007:

e You will see a message that says the file you are trying open is in a different format
than specified by the file extension. Click Yes.

e If you see the security warning Data connections have been disabled , click
Options , and then click Enable this content , and then click OK.

7. Drag the fields from the PivotTable Field List to the PivotTable. For more information, see Microsoft
Office Excel Help.

8. To refresh data in the file:

e In Microsoft Office Excel 2007, click the Data tab, and in the Connections area, click
Refresh All .

e |n Microsoft Office Excel 2003, on the Data menu, click Refresh Data .

To save the exported data to a file, in Excel, on the File menu, click Save.
Each time you open the file, you have the option to refresh data from the Microsoft Dynamics CRM
database.

F Tips

e |f you export a dynamic worksheet or PivotTable that you think will be useful to other Microsoft
Dynamics CRM users, you can add the list as a report, and then share it with others, or make it
available to all Microsoft Dynamics CRM users.

e |f the recipients are in the same domain as you, and are Microsoft Dynamics CRM users, you can e
mail a dynamic Excel file, or store it as a shared file. When recipients open the dynamic file, they
will see data they have permission to view in Microsoft Dynamics CRM, sothe data they see may be
different from what you see.

Notes
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e There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel
2003 comma-separated value (CSV) file.

To ensure that the file is exported correctly, you m ust have data in every row of the last column of
the list you are exporting. You can add a space or other character in last column of the file or
reorder the columns so that the last column always contains data. More information: Microsoft
Knowledge Base Article 77295

e You must use Microsoft Office Excel XP, Excel 2003, or Excel 2007 to export a list to a PivotTable.

e Some system views, such as Accounts: No Campaign Activities in Last 3Months, can be exported only
to a static Excel worksheet.

Export data to an Excel dynamic worksheet

1. In any area with a list of records, on the Actions toolbar, click the Export to Excel button Lgl

2. Click Dynamic worksheet

3. By default, an exported worksheet includes the fields that are displayed in the list, using the same
field order, sorting, and field widths.

To make changes to the columns, click Edit Columns . You can make the following types of
changes:

k' Change the column order

To change the column order, select a column heading, such as Account Name , and then under Common

Tasks, click the Move Left button e or the Move Right button 6 to move the column.

k- Add columns

a. Toadd columns to the export list, click Add Columns .

b. To add columns for the main record type, select it, and then in the Add Columns list, click to
select fields that you want to add as columns.

c. To add columns from related records, first select the related record type, and then in the Add
Columns list, click to select fields that you want to add as columns.

d. ClickOK.

F Configure sorting

To change the sort order, click Configure Sorting , in the Column list, select the column that you want to
sort, in the Order area, click Ascending Order or click Descending Order , and then click OK.
You cannot sort on columns from related record types.

k' Change column width
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To change the column width that will appear in the Excel worksheet, select a column heading, such as
Account Name , click Change Properties . In the Change Column Properties  dialog box, select the
width (in pixels) that you want, and then click OK.

F Remove columns

To remove a column, select the column heading that you want to remove, and under Common Tasks ,
click Remove , and then in the confirmation message, click OK.

4. Click OK, and then click Export .
5. View the file containing the dynamic worksheet:
a. To view the worksheet, click Open.

b. If you are using Microsoft Office Excel 2003, click Enable automatic refresh

T ORIV
If you are using Microsoft Office Excel 2007:

e You will see a message that says the file you are trying open is in a different format

than specified by the file extension. Click Yes.
e If you see the security warning Data connections have been  disabled , click
Options , and then click Enable this content , and then click OK.

6. To refresh data in the file:

e In Microsoft Office Excel 2007, click the Data tab, and in the Connections area, click
Refresh All .

e |n Microsoft Office Excel 2003, on the Data menu, click Refresh Data .

To save the exported data to a file, in Excel, on the File menu, click Save.

Each time you open the file, you have the option to refresh data from the Microsoft Dynamics CRM
database.

F Tips

e |f you export a dynamic worksheet or PivotTable that you think will be useful to other Microsoft

Dynamics CRM users, you can add the list as a report, and then share it with others, or make it
available to all Microsoft Dynamics CRM users.

e |f the recipients are in the same domain as you, and are Microsoft Dynamics CRM users, you can e
mail a dynamic Excel file, or store it as a shared file. When recipients open the dynamic file, they

will see data they have permission to view in Microsoft Dynamics CRM, so the data they see may be
different fr om what you see.

Notes

e There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel
2003 comma-separated value (CSV) file.
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To ensure that the file is exported correctly, you must have data in every row of the las t column of
the list you are exporting. You can add a space or other character in last column of the file or
reorder the columns so that the last column always contains data. More information: Microsoft
Knowledge Base Article 77295

e Some system views, such as Accounts: No Campaign Activities in Last 3 Months, can be exported only

to a static Excel worksheet.

Importing Data

Im porting Data

Microsoft Dynamics CRM provides several tools to add bulk data into Microsoft Dynamics CRM:

e Import Data Wizard

e Data Migration Manager

If you want to automate the import or migration process, you can use the information in the  Microsoft Dynamics CRM
Software Development Kit to write a custom import tool.

Comparison: Import Data Wizard and Data Migration Manager
The following table summarizes which tool to use for each task:

Task

Bring data into more than 50 Microsoft
Dynamics CRM record types

Bring data into custom record types
and attributes

Use multiple source files that contain
related data

Assign records to multiple users

Detect duplicates

Delete all records associated with one
job

Automatically map data based on
column headings in source file

Microsoft Dynamics CRM 4.0

Import Data Wizard

Yes (All users with appropriate
permissions can import data.)

Yes

No (You can import only one file at a
time.)

No (The wizard assigns all records to
one user.)

Data Migration Manager

Yes (Only the system administrator

can migrate data.)

Yes

Yes

Yes

Yes No (You can run duplicate detection
after migrating the records.)
No Yes
Yes No
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Map drop-down list values Yes No (To map list values, you must
manually edit a data map.)

Set value of Created On attribute No Yes
from source data

Customize Microsoft Dynamics CRM to No (Customization must be performed Yes (Data Migration Manager can
match data prior to import.) create custom record types and
attributes.)

Yes (Complex data transformations

Transform data No (You must use a one-to-one !
are possible.)

mapping of attributes.)

Send e-mail message to user when Yes No
task is done

Importing Your Data Using the Import Data Wizard

The Import Data Wizard is useful for importing data you have stored in a spreadsheet or importing leads that you have
purchased. It can be used for importing data into most record types. The Import Data Wiza rd is designed for use by
people in sales, marketing, and customer service to use with their own data. All data imported will be owned by the
user who does the import, or, if the user has permission to assign records, all records in an import can be assign ed to
another user.

The data must be in a comma-separated value (CSV) file or in a delimited text (.txt) file with columns delimited by
commas. You can export or save data in comma-delimited format from many applications, such as Microsoft Office
Excel or Microsoft Office Outlook contacts, and most databases.

If your import file uses column headings that match Microsoft Dynamics CRM display names, the file is automatically
mapped. If you frequently import data that is in the same format, you can use a dat a map to map your data to speed
the import process.

Microsoft Dynamics CRM processes imports in the background, and you can select to receive an email message when
the import completes. Once an import completes, you can review the records that succeeded or failed to import. You
can export failed records into a separate file so that you can fix them, and then try to import them again. Or, you can
delete all records associated with an import.

If your system administrator has enabled duplicate detection during import, you can select whether to import
duplicates. After an import completes, you also can run a duplicate -detection job to detect potential duplicates.

Migrating Data Using the Data Mi gration Manager

The Data Migration Manager is a downloadable tool that can be used to migrate data from another customer
relationship management system to Microsoft Dynamics CRM. The tool typically is used when Microsoft Dynamics CRM
is first installed to migrate data from previous systems, but also can be used later. It can migrate:

e Multiple files containing record types that are related to each other, such as accounts with related
contacts

e Records that need to be assigned to different Microsoft Dynamics CRM users
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e Notes and attachments
You can delete all records associated with a specific datamigration job.
Data to be migrated must be stored in comma -separated value (CSV) files.

To simplify the migration process, a data map can be used to map data fr om your source data to Microsoft Dynamics
CRM. Data maps can be exported and imported, and can be edited manually if needed.

Sﬁ? The data migration tools must be used by a person with the System Administrator security role in Microsoft
Dynamics CRM.

More information: Install and Run the Data Migration Manager Back to the top

Work with Imports

¥ Data that can be imported

Data can be imported into system attributes and custom attributes in most record types, and can also be imported
into custom record types.

For a complete list of record types you can import into, on the second page of the Import Data Wizard, view the
values in the Record Type list.

Prepare a file for import

F Can | do this task?

This task requires permissions that are found in all default security roles. More information about
specific permissions and performing this task while offline: Common Task Permissions

Follow the guidelines in this topic to ensure that your file imports successfully.

1. Put records for each record type in a separate file.
You can import only one record type at a time. For ease of use, name the file the same name as the
record type in Microsoft Dynamics CRM. For example, put all your contact records in a file named
contacts.txt or contacts.csv.

2. Only put records that need to be assigned to one user in each file.

3. The file must be in delimited text format (.txt) with columns separated by commas, or in a comma -
separated values (.csv) format.

You can easily create delimited txt or.csv format files by using Microsoft Office Excel.

F If your file uses only ASCII characters, save the file as a comma-delimited values (.csv) file.

e In Microsoft Office Excel, click Save As, and select CSV (Comma delimited)(*.csv)

F If your file uses non -ASCII characters, save the file as a Unicode text (.txt) file and change the field
separator to commas.

If your import file contains non -ASCII characters, the import file must be in a Unicode or UTF-8 format.
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In Excel, click Save As, and select Unicode Text (*.txt)
Use Notepad to open the.txt file.

Search for commas in the file. Enclose any data that includes commas with double-quotes. For
example:
"23 State Street, Apt 2".

Replace alltab characters with commas.

a. In Notepad, select the tab character with the keyboard or mouse and press CTRL+C to
copy it to the Clipboard.

b. On the Edit menu, click Replace .

c. Inthe Find what box, press CTRL+V to paste the Clipboard contents. This pastes the
tab character.

d. Inthe Replace with box, type a comma (,).
e. ClickReplace All .
f. ClickSave As.

g. Inthe Save astype box, select Text Documents (*.txt)  , and in the Encoding box,
select Unicode .

Make sure the first line of the file contains column headings.

Edit your file and add column headings if they are not already present.

If the column headings exactly match attribute display namevalues in Microsoft Dynamics CRM,
columns in your source file will be mapped automatically to Microsoft Dynamics CRM columns which
will save time.

Tips

e To identify display name values, open the form for the record type as if you were creating a
new record. The labels on the form typically match the display names, although it is possible
for your system customizer to have changed the form label values.

g?lf you have the appropriate security role, you identify display names in the Customization
area:

1. Inthe Navigation Pane, click Settings , click Customization , and then click
Customize Entities

2. Open the entity, and then click Attributes

e |f you are working in a multi -language environment, automatic mapping of columns uses the
display names from the user interface language, set on the Regional Options tab of the
Set Personal Options  dialog box. More information: Set Personal Options

Make sure the first column heading is not the name of a record type.

The first column heading in your file cannot be the name of another record type. For example,
phone call, task, letter, fax, and appointment record s all require a Subject column. As Subject is also
the name of a record type, the Subject column must not be the first column in your file.

Make sure data exists for all businessrequired attributes.
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A record will only import if all Microsoft Dynamics CRM businessrequired attributes are mapped,
and if the data exists in each of the source columns that are mapped to the required attributes.

You can either determine the required attributes in advance, or use the Import Data Wizard to
identify missing required mappings. In either case, make sure you have required data in each
record. To determine which fields are business-required, open the form for the record type as if you
were creating a new record, and identify fields that are marked with a red asterisk (*).

The following list shows default business-required fields for commonly imported record types.

e  Account: Account Name

e  Contact: Last Name

e Lead: Topic, Last Name , Company Name

e  Product: Default Unit , Unit Group , Decimals Supported
e  Campaign Response:Parent Campaign , Subject , Owner

If records in your import file should be related to an existing Microsoft Dynamics CRM record,
make sure the column heading and data in the column that connects the records is valid.

e  The value in the column that refers to another record must be unique in the primary
attribute for the related record. The lookup is not case -sensitive.

For example, if you are importing a contact that you want associated with an existing
account, you must have a column in your source file containing the Account Name for an
existing Microsoft Dynamics CRM account record. If you want to perform automatic mapping,
the column heading for this column should be Parent Customer

The Parent Customer attribute can be resolved either to an account or contact. The Import
Data Wizard looks for a unique account or contact record. If there is a contact record and an
account record that have identical values in the Account Name field in the account record
and the Full Name field in the contact record, the record will not be imported.

e  The value in the column can also be a Microsoft Dynamics CRMglobally unique identifier
(GUID).

e If the column in your source file that is used to create the relationship contains multiple
values, edit the data to contain just one value.
For example, if you are importing e -mail activities, and your source data has a record with
multiple values in the To column, edit the data to contain just one value.
F Example showing sample leads to import

The following lines show what the data might look like for a .csv format file containing leads to import. The first line
contains the field names, and the remaining lines are imported as data.

Company,Last Name,First Name,Topic,Email,Mobile Phone
Designer Bikes,Groth,Br ian,Mountain bikes,someone@example.com,555 - 555- 0112
Major Sporting Goods,Bedecs,Anna,Components,,555 -555-0171

k' Example showing sample products to import

The following lines show the minimum amount of data required for a .csv format file containing products to import.
The first line contains the field names, and the remaining lines are imported as data. Because Unit Group and
Default Unit are record types in Microsoft Dynamics CRM, the values for these columns must map to valid values in
Microsoft Dynamics CRM.

Product,Unit Group,Default Unit,Decimals Supported
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Front Brakes,Single pair,Unit pair,0
Vest,Clothing,Single article,2

Note

By default, the maximum size of the file that you can upload is 4 megabytes (MB). This can be changed by your system
administrator. More information: Microsoft Knowledge Base Article 2%626

Import records from a file

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

To ensure a successful import, be sure to follow the steps in Prepare a file for import

1. In the Navigation Pane, click Workplace , and then under My Work , click Imports .

T ORT
On the Tools menu, click Import Data

2. On the Actions toolbar, click New .
3. Click Browse to find the file to import.

4. If you are not using the default delimiters, which for data are double quotation marks (" ") and for
fields are commas (,), you can select other symbols as the delimiters.
Other recognized delimiters for data include: single quotation marks (' ') and none.
Other recognized delimiters for fields include: colons (:), tabs, and semicolons (;).

5. Click Next .
6. Select the record type to import the records to.
7. Determine how the source data will be mapped to Microsoft Dyn amics CRM data:

e [f the column headings in your file exactly match Microsoft Dynamics CRM display names
Display, an automatic data map will be used, and the word Automatic will be entered in the
Data map box.

e |fthe Data map box remains empty, check your data file to make sure the column headings
are actual display name values from the selected record type, or click the Lookup

button @I to select a data map. If you do not yet have a data map, you need to create one,
and then return to the wizard. More information: Work with Data Maps

8. In the Mapping Results section, if there are any unmapped columns or errors, click View Details .
e If you have columns that cannot be imported, you will see Ignored columns:  Count
Two types of columns are ignored: computed columns, such as Full Name in the contact

record type, and columns for attributes that cannot be created and updated, such as Created
On, Created By , Modified On , and Modified By in all record types.

e If you have not mapped all business-required columns, you will see Unmapped required
columns Count
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9. After reviewing the details, if none of them need to be fixed, click OK.
T ORI

If you need to fix your source file, open your source file and fix the problems, click Back, and return
to step 3 to select your source file.

10. ClickNext .

11. Inthe Assign To section, to assign all the records in this import to a different user, click Lookup ,
and select the user.
This option is not available for organization-owned record types such as Product.

12. By default, if duplicate detection is enabled for this record type, duplicate records are not imported.
If you want to import duplicates, select Impor t duplicate records
This option is not available if duplicate detection is not enabled or not available for the record type
you are importing.

13. Click Next .

14. Rename the import job if needed, change the notification options if needed, and then click Import .
An import job is started in the background. You can continue to work in Microsoft Dynamics CRM
while the import runs.

F Tips

e The direct import of Microsoft Office Outlook contacts is not supported in Microsoft Dynamics CRM.
However, you can export your Outlook contacts to a comma separated value (.csv) file, and then
import them into Microsoft Dynamics CRM by using the Import Data Wizard. For more information
about how to export items in Outlook, see the Help information in Outlook.

e To pause or postpone an import:
1. Inthe Navigation Pane, click Settings , and then click System Jobs .

2. Select the scheduled import job, and then on t he More Actions menu, click Pause or
Postpone .

Note

By default, the maximum size of the file that you can upload is 4 megabytes (MB). This can be changed by your system
administrator. More information: Microsoft Knowledge Base Article 295626

Create a data map for use with import

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about
specific permissions and performing this task while offline: Common Task Permissions

Data maps created for use with data import are not the same as data m aps used for data migration. You cannot
use a data migration data map with the Import Data Wizard.

1. In the Navigation Pane, click Settings , click Data Management , and then click Data Maps .
2. To edit a data map, double-click the data map.

T ORT
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To create a new data map, on the Actions toolbar, click New , type a name and select the record
type that you will use the data map with.

3. Create a sample commaseparated value (CSV) file containing:

e A heading row containing all column headings that might be included in a source file you plan
to import.

e  Data rows that have data for each Microsoft Dynamics CRMdrop-down list attribute. For
example, if you are importing leads, lead source data is stored in the Lead Source drop-
down list attribute in Microsof t Dynamics CRM. You would need one row of data to include
every possible lead source used in your source data, such as Web site inquiry, tradeshow, and
advertisement.

e  File size smaller than 50 KB.
F Tip

e  One way to create this file is to use a file you intend to import as your sample file. However, the
sample file must be smaller than 50 KB.

4. Load your sample file:
a. Click Attributes , and then click Load Sample Data

b. Click Browse , select the comma-separated value file, click Open, and then click OK.

The source file column headings will be displayed.
F Tip

e  The sample file is not saved as part of the data map. You need to load the sample data each time
you edit your data map.

Map each source file column heading to a Microsoft Dynamics CRM attribute:
Under Source , select a source file column heading from the Column Headings column.
a. Select an attribute from the listed unmapped Microsoft Dynamics CRM attributes.

Important  All businessrequired attributes must be mapped. To identify unmapped business -
required attributes, in the Target area, in the Unmapped Attributes  box, select Business
Required .

b. ClickMap.
F Tips

e  To change a mapping, click the source value, and then click Unmap .

e Toignore values in a column during import, click the source column heading, and then click
Ignore .

e To map one source column to multiple Microsoft Dynamics CRM attributes, select one attribute
and click Map, and then select another attribute and click Map again.
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e The Created On and Modified On attributes cannot be imported so they do not appear in the
target attribute list.

If you selected any Microsoft Dynamics CRMdrop-down list attrib utes, map all values in each
list.
If you didn't select any drop -down list attributes, go to step 7.

Under Mappings , click List Values .

a. Under List Attributes , select a source file column heading from the Column Headings
column.

b. Under Corresponding List Values, for each item in the Source Record Typecolumn, select
a value from the Microsoft Dynamics CRM Value list, and then click Map .
The mapped value will appear in the Target Record Typecolumn.

c. In addition to any values from your sample file, you must also specify a target Microsoft
Dynamics CRM value for rows in your source data that have no data in this attribute
(Empty) , and for rows that contain data that is not mapped (Unmapped) .

For example, if you are importing leads, you might want to map any empty or unmapped
values in the Rating column to Cold.
F Tips
e |f your list of values from your sample file does not appear in the list, under Mappings , click
Attributes , and reload your source sample file.

e |f you need additional list values in Microsoft Dynamics CRM, contact your system administrator or
system customizer. More information: Requesting User Interface Changes

e  Once you have mapped a value, you can change t to another value, but you cannot unmap it.

Click Save or Save and Close .

View the progress and results of an import, and correct errors

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

You must wait for an import job to complete before you can repair fai lures. If you selected to receive e-mail
notification in the Import Data Wizard, you will receive an e -mail message when the import completes.

1. In the Navigation Pane, click Workplace , and then under My Work , click Imports .
F Monitor the progress of the import. To monitor status for an import, watch the ~Status Reason column. The values
will change from Submitted to Parsing to Transforming to Importing to Completed .

These values correspond with the three stages of each import: parsing the file, transforming the data, and
importing the data.

For detailed information about the progress of the import job, double -click the import job record, and then under
Details , click System Jobs . One system job is created for each import stage.
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Tip: To refresh the status, click the Refresh button .

2. Once an import has completed, view the summary information showing the number of records created
and the number of records containing errors.

3. To open the import record to view the records that did not import, double -click the import record.
4. To view rows that were successfully imported, under Details , click Record TypesCreated .
5. To view rows that were not imported, under Details , click Failures .

To export rows that failed to import to a new comma -separated value (CSV) file, clickExport Error
Rows . You can correct the errors in this file, and then import it.

Work with Data Maps

Create a data map for use with import

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

Data maps created for use with data import are not the same as data maps used for data migration. You cannot use a
data migration data map with the Import Data Wizard.
1. In the Navigation Pane, click Settings , click Data Management , and then click Data Maps .
2. To edit a data map, double-click the data map.
T ORT

To create a new data map, on the Actions toolbar, click New , type a name and select the record
type that you will use the data map with.

3. Create a sample commaseparated value (CSV) file contaning:

e A heading row containing all column headings that might be included in a source file you plan
to import.

e  Data rows that have data for each Microsoft Dynamics CRMdrop-down list attribute. For
example, if you are importing leads, lead source data is stored in the Lead Source drop-
down list attribute in Microsoft Dynamics CRM. You would need one row of data to include
every possible lead source used in your source data, such as Web site inquiry, tradeshow, and
advertisement.

(] File size smaller than 50 KB.
F Tip

e  One way to create this file is to use a file you intend to import as your sample file. However, the
sample file must be smaller than 50 KB.

4. Load your sample file:

a. Click Attributes , and then click Load Sample Data
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b. Click Browse , select the comma-separated value file, click Open, and then click OK.

The source file column headings will be displayed.

F Tip

F Tips

The sample file is not saved as part of the data map. You need to load the sample data each time
you edit your data map.

Map each source file column heading to a Microsoft Dynamics CRM attribute:
Under Source , select a source file column heading from the Column Headings column.
a. Select an attribute from the listed unmapped Microsoft Dynamics CRM attributes.

Important  All businessrequired attributes must be mapped. To identify unmapped business -
required attributes, in the Target area, in the Unmapped Attributes  box, select Business
Required .

b. ClickMap.

To change a mapping, click the source value, and then click Unmap .

To ignore values in a column during import, click the source column heading, and then click
Ignore .

To map one source column to multiple Microsoft Dynamics CRM attributes, select one attribute
and click Map, and then select another attribute and click Map again.

The Created On and Modified On attributes cannot be imported so they do not appear in the
target attribute list.

If you selected any Microsoft Dynamics CRMdrop-down list attrib utes, map all values in each

list.
If you didn't select any drop -down list attributes, go to step 7.

F Tips

Under Mappings , click List Values .

a. Under List Attributes , select a source file column heading from the Column Headings
column.

b.  Under Corresponding List Values, for each item in the Source Record Typecolumn, select
a value from the Microsoft Dynamics CRM Value list, and then click Map.
The mapped value will appear in the Target Record Typecolumn.

c. Inaddition to any values from your sample file, you must also specify a target Microsoft
Dynamics CRM value for rows in your source data that have no data in this attribute
(Empty) , and for rows that contain data that is not mapped (Unmapped) .

For example, if you are importing leads, you might want to map any empty or unmapped
values in the Rating column to Cold.
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e If your list of values from your sample file does not appear in the list, under Mappings , click
Attributes , and reload your source sample file.

e If you need additional list values in Microsoft Dynamics CRM, contact your system administrator or
system customizer. More information: Requesting User Interface Changes

e  Once you have mapped a value, you can change it to another value, but you cannot unmap it.

Click Save or Save and Close .

Export a data map

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

1. In the Navigation Pane, click Settings , click Data Management , and then click Data Maps .
2. On the Actions toolbar, click Export .

3. In the File Download dialog box, click Open or Save.

Notes

e Data maps created for use with data import are not the same as data maps used for data migration.
You cannot use a data migration data map with the Import Data Wizard.

e Exported XML files containing data maps can be edited manually. The complete syntax canbe found in
the Data Map Schema section of the Microsoft Dynamics CRM 4.0 Software Development Kit

Import a data map

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about
specific permissions and performing this task while offline: Common Task Permissions

1. In the Navigation Pane, click Settings , click Data Management , and then click Data Maps .
2. On the Actions toolbar, click Import .

3. In the Import Data Map  dialog box, type the name of the file to import, or click Browse and locate
the file, and then click OK.
A data map must be a well-formed and valid XML file.

Notes

e Data maps created for use with data import are not the same as data maps used for data migration.
You cannot use a data migration data map with the Import Data Wizard.

e Exported XML files containing data maps can be edited manually. The complete syntax can be found in
the Data Map Schema section of the Microsoft Dynamics CRM 4.0 Software Development Kit
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Tip

If you create a data map that you think will be useful for other users in your organization, you can share it. More
information: Share or AssignRecords

Install and Run the Data Migration Manager
Concepts:

e Importing Data

Install and run the Data Migration Manager

k' Can | do this task?

This task requires the System Administrator security role, and you must also be in the local
Administrators group on the computer on which you are installing Data Migration Manager. More
information about specific permissions and performing this task while offline: Configuration Permissions

The Data Migration Manager is included on the Microsoft Dynamics CRM Client CD.

1. Install Data Migration Manager:

a. On the computer on which you plan to install Data Migration Manager, use Microsoft Internet
Explorer to browse to your Microsoft Dynamics CRM server.
If you cannot use Microsoft Dynamics CRM from this computer, you will not be able to install
and use Data Migration Manager on this computer.

e |f the Microsoft Internet Explorer Connectto dialog box is displayed, select the
Remember my password  check box.

e [f you are using Windows Vista:

a. In Control Panel , click User Accounts , and then click Manage Your
Netw ork Passwords

b. Inthe Store User Names and Passwords screen, click Add .

c. Inthe Store Credential Properties screen, specify the name of your Microsoft
Dynamics CRM server.

d. Inthe Credential type section, select A Web site or program credential
click OK, and then click Close.

b. Insert the Microsoft Dynamics CRM Client CD, and doubleclick Setup.exe.

c. On the Setup screen, click Install Microsoft Dynamics CRM Data Migration Manager
and follow the instructions in the setup wizard.

e If you choose to install Microsoft SQL Server Express, note that it cannot be installed on
a compressed drive.

e If you choose to use an existing SQL Server, note that it must be in the same domain
as the computer on which you are installing Data Migration Manager.

2. Configure Data Migration Manager:
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a. Onthe Start menu, pointto All Programs , point to Microsoft Dynamics CRM , and then
click Data Migration Manager
It takes the Data Migration Manager a few minutes to start the first time.

b. Complete the steps in the configuration wizard.

Note: If you are using a computer running Microsoft SQL Server rather than Microsoft SQL
Server Express, by default the configuration wizard will attempt to connect to the CRM
instance on your server. If you prefer to use a different instance, on the Specify SQL Server
page, specify the instance name in the format server_namd instance_name

3. Start the Data Migration Manager:

e  Onthe Start menu, pointto All Programs , point to Microsoft Dynamics CRM , and then
click Data Migration Manager

Notes:

0 Data Migration Manager cannot be used while Microsoft Office Outlook is running.
If you have closed Outlook, and get an error message stating that Outlook is still running, you
need to use Task Manager to stop the Outlook.exe process.

0 Data Migration Manager can only be used by the person who installs it.

Note

For information about how to prepare your files for data migration, and for help troubleshooting Data Migration
Manager configuration, after Data Migration Manager is installed, on the Start menu, point to All Programs , point to
Microsoft Dynamics CRM , and then click Data Migration Manager Help

Analyzing Information

Running Reports and Analyzing Data
When you want to analyze data or view a report in Microsoft Dynamics CRM, there are several ways to view the
relevant data:

e Run a default report. More information: Default Reports

e Use Advanced Find to search for the subset of data you need. Then export the results list to a static or
dynamic Microsoft Office Excel worksheet or a PivotTable for further analysis. Once the data is
exported, you can create your own Microsoft Office Word file and mail -merge the data. More
information: Export Data to Excel

e Create your own report:

e  Use the Report Wizard to create a new Reporting Services report. The wizard helps you group
and summarize data, create charts and tables, and generates an easily printable report. More
information: Create, Edit, or Copy a Report Usingthe Report Wizard

e  Add any exported Excel file as a personal report, and share it with your colleagues if
appropriate.

Or, ask your system administrator or system customizer to add any exported Excel file as a
report available to everyone in your organiz ation.

If the Excel file is dynamic, the data in the file will be refreshed any time the file is opened,
and each person who runs the report will see data that only they have permission to see.

More information: Customizing and Organizing Reports
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e Add any file or link to a Web page as a personal report, and share it with your colleagues if
appropriate. More information: Customizing and Organizing Reports

e Write a new report using Microsoft Office Excel, Microsoft SQL Server Reporting Services, or
other ODBC-compliant reporting tools. Add it as a personal report, and share it with your
colleagues if appropriate. More information: Write a Report Using Report-Writing Tools

Reports can be used when Microsoft Dynamics CRM for Outlook is offline. More informatian: Working Offline

Work with Advanced Find

Create, edit, or save an Advanced Find search

k' Can I do this task?

This task requires permissions that are found in all default security roles. More information about
specific permissions and performing this task while offline: Common Task Permissions

1. On the Standard toolbar, click Advanced Find .

Tip: Advanced Find starts with criteria based on where you are in Microsoft Dynamics CRM. If you
click Advanced Find from a view, the criteria for that view will be preloaded for you.

T ORT

To edit a saved search, on the Standard toolbar, click Advanced Find , click the Saved Views tab,
and then double-click the saved view.

2. Specify the search criteria.

e |f Show Details is visible in the criteria toolbar, click it.
k' Specify what to search for

b. In the Look for list, select the type of record you want to search for, such as
Accounts , Leads, or Users.

C. Click Select to select criteria for the search, including the field to search on (for
example, Account Name or City ), the query relational operator, and the values to locate (for
example, "Seattle" or "E-mail").

You can select fields from the current record type, or from related records.

e  For some values, you can click the Lookup button @I to open the Select Values dialog
box and select the value you want.
At the bottom of the Select list, the Related section shows related record types. When you select a
related record type, a new Select link appears to select fields from this related record type.

F Clear, delete, or group search criteria clauses

e  Clear all search criteria to start over.
a. Click Clear to remove all criteria.

b. In the confirmation message, click OK.
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e Delete a row of search criteria.
Click the Options menu  button - next to a search criteria row, and then click Delete .
a. In the confirmation message, click OK.
e  Group criteria.

. Click the Options menu button » next to a search criteria row, and then click Select Row .
To group search criteria, you must select two or more rows for the same record type. For example,
Sales Stag e and Est. Revenue are both field values in the Opportunity record type and two rows
that specify search criteria for these fields can be grouped. However, rows with field values from
Account and Opportunity record types cannot be grouped.

a. On the Filter toolbar, select Group AND or Group OR .
b. Repeat steps a and b to create additional criteria groups.
e  Select and deselect grouped criteria.

Click the Options menu  button -+ next to a search criteria row that has been selected, and
then click Deselect Row . You can unselect rows from a group or individually.

a. Click the Options menu  button = next to the group, and then click Select Group to select
a group, or click Deselect Group to unselect a group that has been previously selected.

e Add a search criteria clause to a criteria group.
Click the Options menu  button = next to the group, and then click Add Clause .
a. Add search criteria to the new clause.
e Ungroup rows of criteria that you have grouped together using Group AND or Group OR .

Click the Options menu  button = next to the group you want to ungroup, and then click
Ungroup

a. Repeat this step to ungroup additional search criteria groups.

e Change aGroup AND group to a Group OR group, or a Group OR group to a Group AND
group.

Click the Options menu  button - next to the group, and then click Change to OR or
Change to AND .

a. Repeat this step to change additional search criteria groups.
e Hide or delete a row in Simple view:

To hide a row, click the Options menu button = next to a search criteria row, and then click
Hide in Simple Mode

a. To make a hidden row visible, click Show in Simple Mode

Specify the columns to include in the search results.
Click Edit Columns , and then click Add Columns .
a. Select the record type that includes the columns you want to add.

b. Select the check box next to the columns you want to add. If a column isn't listed, contact
your system administrator.

c. ClickOK.

d. The following options are also available:
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¥ Tips

e  To adjust the width of a column, click the column, click Change Properties , select a

width, and then click OK.

e To reorder columns, select a column, and use the arrow keys to move it to the left or
right.

e Toremove a column, select it, and then click Remo ve.
Click OK.

Specify the sort order.

Click Edit Columns , click Configure Sorting , and specify the column to sort on, and the
sort order.

Tip: Each view is sorted by only one column. However, after you click Find, you can sort by
additional columns. To sort a search results list by an additional column, press SHIFT while
you click the additional column header.

You can only sort on columns from the primary record record type.

Save the search as a saved view.

If you're saving an existing saved view, click Save. If you are saving a new view or want to
change the name of the view because you changed the criteria, click Save As.

In the Query Prope rties dialog box, in the Name field, type a name for the search.
In the Description box, type a brief description, and then click OK.

The search is saved as a view and appears on the Saved Views tab of the Advanced Find
form. This new view is also available from the list page for the record type in the View box,
in the My Views section.

Click Find . The selected records are displayed.

Click Back to Query to return to the Find tab.

e When you specify search criteria to find activity records, you can either search through all types of
activities or select one type of activity to search, such as Task or Appointment.

e The columns that are displayed by default are controlled by the Advanced Find View for the record
type. More information: Work with Entities.

e If you need to search based on the names of people who participated in an activity, in the Advanced
Find criteria, you must search fields in the related activity party. You can search based on the
person's name (Party field), or by their role in the activity, such as sender or recipient
(Participation Type field).

For example, to find e-mail messages sent to a specific contact:

In the Activities list, in the Type box, select E-mail .

Click Advanced Find , and then click Show Details .

Click Select , and then in the Related section, select Activity Parties (Activity)
Under Activity Parties (Activity) , click Select .

In the Fields section, click Participation Type , click Enter Value , and then click the

Select Values button El
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f.  Inthe Available Values list, select To Recipient , click the Add Selected Records

button , and then click OK.

g. Under Activity Parties (Activity) , click Select .
h. Inthe Fields section, click Party .

i.  Click the Equals Current User operator, and change it to Equals .

j-  Click Enter Value , and then click the Lookup button @I

k. Inthe Look for box, select Contact , enter some letters to search for, and then click Start
search .

. Select the contact, click the Add Selected R ecords button , and then click OK.

m. Inthe Advanced Find page, click Find .

Note

You cannot use Advanced Find to find records related to quick campaigns.

Working with saved Advanced Find searches

k' Can | do this task?

This task requires permissions that are found in all default security roles. More information about specific
permissions and performing this task while offline: Common Task Permissions

e You can run, share, assign, delete, or deactivate a saved view that you own.

If another user has shared a saved view with you, what you can do will depend on the specific
privileges they have given to you: Share, Assign, Delete, or Write.

F Run a saved search

On any list page in the View box, in the My Views section, select a saved view.
If there is not a My Views section, there are no saved searches for this record type.

T ORI

On the Standard toolbar, click Advanced Find , and then click the Saved Views tab. Double-click a saved
search, and then click Find.

F Share a saved search

1. On the Standard toolbar, click Advanced Find , and then click the Saved Views tab.
2. Select the view. On the Actions toolbar, click More Actions , and then click Sharing .
3. Inthe sharing dialog box, under Common Tasks , click Add User/Team .

4. Inthe Look Up Records dialog box, in the Look for list, select the type of record you want to
find.

5. Inthe Search for records box, type the first few letters of the name of the record to narrow

your search, and then click the Find button EI
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6. In the list of available records, click a user or team to select it, and then click the Add Selected
Records button to add the user or team to the Selected records list.
7. ClickOK.

8. Inthe sharing dialog box, select the type of share access that you want . The available permissions
are: Read, Write, Delete, Append, Assign, or Share.

9. ClickOK.
The saved view will show up in the My Views section of your coworker's View list.

Tips

e To cancel any changes that you have made and retain the previous permissions settings, click
Reset .

e To select or clear all permissions on a selected item, cl